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Welcome to Renque 

Renque is a powerful software environment designed for general-purpose discrete 
event simulations. It has a comprehensive graphical user interface and a versatile 
simulation engine, which enable you to rapidly build accurate simulations, for a wide 
range of applications.  
 
The phrase simulation generally refers to a technique of imitating the behavior of 
some process or system by means of operating a project. Simulations are used to 
acquire numerical information and improve understanding of systems, in an 
environment where experimentation with the real system is undesirable or 
impossible.  
 
Renque is a software tool developed to create and operate discrete event simulation 
models. A discrete event is something that happens in an instant of time, with zero 
duration. Although gradual system transitions can be represented in a Renque 
project, the program was designed primarily to deal with instantaneous changes. 
 
Renque is a full-fledged Microsoft Windows application, suitable to analyze a virtually 
unlimited range of simulation objectives. Among the many helpful features that make 
modeling with Renque efficient and enjoyable are powerful animation tools,  
integrated calendar and scheduling tools, a helpful event viewer and a script 
language for customization. 
 
In this document, the names of user interface controls are displayed in bold, where 
suitable. The names on Renque object properties are written with a capital letter, and 
property values are generally displayed in italic. Internal document hyperlinks are 
underlined.  
 
Licensing and support 
Renque is provided free of cost. The software is available for download on the 
Renque website www.renque.com.  
  
System requirements 

Operating system: Microsoft Windowsã 7 or higher 64-bit.  

http://www.renque.com/
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1 Getting started 

This section is intended to familiarize new users with the Renque simulation 
environment. It contains an introduction to the user interface and two tutorials: 
 
Á Quick start guide Introduces the Renque user interface and the principles of 

simulation modeling in Renque. 
Á Tutorial Demonstrates the construction and operation of a simple 

project for a small supermarket. 
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1.1 Quick start guide 

This topic contains an elementary tutorial that introduces the main features of 
Renque. You will visit and operate the most important elements of the user interface 
as you are guided through the construction of a very simple simulation model.  
 
When Renque is started it briefly displays an identifier splash window followed by the 
appearance of the primary user interface window, recognized by the project name in 
the title bar of the window. Models are constructed and simulation runs are controlled 
and viewed on the viewport, which is the large central area on this window. All other 
modeling and simulation controls are either located on the main window or 
accessible from it.  
 
A Renque simulation has the three key elements: servers, links and entities. 

¶ Server objects act mainly as container and processor of entities. They are 
represented by static pictures in the viewport. Servers are created on the 
viewport with the help of the mouse. 

¶ Links function as means to transport entities between servers and to create and 
destruct entities. Links are also created by mouse operation in the viewport. They 
are displayed by lines. 

¶ Entities are dynamic items in the project. As for servers, they are displayed as 
pictures on the viewport. However, entities are created and destructed during the 
simulation process, and they move around the viewport. 

 
All project elements may or may not represent physical things found in the real world. 
If so, servers typically represent stationary objects such as machinery or storage 
facilities, whereas links are better suited to symbolize routes and roads. Entities are 
more likely to represent mobile or temporary objects such as materials or documents.  
 
The available server templates are found in the Toolbox on the Main window, located 
on the left side of the viewport. To add a server to the project, simply use the mouse 
to drag the template from the Toolbox and drop it on the viewport. Links are created 
directly in the viewport by connecting two servers with the mouse.  
 
You can create a working project as shown in the figure below in the following three 
steps: 
1.  Create a server on the viewport by dragging the Active template from the 

Toolbox and dropping it on the viewport. 
2.  Select the server with a mouse click.  
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3.  Select the Insert menu command Upstream open link to connect a link to the 
server that creates entities. 

 

 
 
And there you are: You've created a Renque simulation project. Now, you can run a 
simulation by clicking the Restart button in the simulation control toolbar underneath 
the viewport. The moving circle-shaped icons represent entities, travelling to the 
server after having been created on the link. Notice the simulation time advancing in 
the right-most pane of the Simulation control toolbar. The animation speed can be 
altered by the Animation speed slider to the right of the restart button.  
 
Stop the simulation by clicking the Pause button adjacent to the restart button. Now 
double-click the Active server on the viewport. A new window named Object 
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properties is opened. This window serves as console to view and modify object 
properties.  
 

 
 
Select the Logic tab in the secondary tab strip and notice the value 1 for the 
Retention property of the server. This value is the cause of the time increment 
observed during the simulation. The server collects an entity from the link as dictated 
by the selected value for the Collect method of the server. The collected entity is 
retained in the server for a period of 1 time unit after which the entity is dispatched 
from the server as dictated by the selected value for the Collect method. The entity is 
deleted because the server has no downstream links. The other tabs on the object 
properties console represent properties that are not of primary concern for the 
present demonstration. The section Object properties provides further details. 
 
Next you are invited to extend the project with a server from the Passive template in 
the toolbox. Close the Object properties console by pressing Cancel to return to the 
Workspace window. Add a passive server to the viewport somewhere to the right of 
the previously created server. Create a link between the two servers as follows: Click 
on a link template  in the Link toolbox to activate link creation. Move the mouse over 
the right edge of the Active server until the mouse pointer changes to a different 
icon. After clicking on the Active server once a line appears that will follow the 
motion of the mouse. Move the mouse over the left edge of the Passive server and 
verify that the mouse pointer changes once again. Now, click on the Passive server 
to create a new link, represented by a line connecting the two servers, after which the 
should look like this: 
 



 Renque user's guide 

- 10 - 

 
 
Restart the simulation. In the animation you can see that the entities travel from the 
Active to the Passive server. On arrival at the Passive server the entities are stored 
in the server object. They are shown on a horizontal line on the server icon. The 
number of stored entities that are displayed is limited by how many fit on this 
residents curve. The counter above the server icon indicates the actual number of 
entities stored.  
 
Subsequently, pause the simulation and double-click the Passive server to open 
the Object properties console again to display the properties of the Passive server. 
Select the Logic tab once more and notice that the text field for the Capacity 
property is left blank. This setting makes sure that the server can store all the entities 
it receives. Also note that the Collect method and Dispatch method have the value 
None, which prevents the server from collecting and dispatching entities  
 
The Collect method and Dispatch method are key to role of a server in the 
simulation. Collecting servers repetitively collect entities upstream via one or more 
connected links. Servers with Collect method None simply store arriving entities. 
Dispatching servers dispatch entities along the downstream connected links to other 
servers, whereas servers with Dispatch method None await collection of entities by a 
downstream connected collecting server. A description of the Simulation mechanism 
is given in the reference section.  
 
Renque also has a number of object types that are not displayed on the viewport. 
These objects are referred to as components, and can be applied to expand the 
capabilities of a project in various ways: Attribute and variable components are used 
to store data, distribution components provide random variation to a project, and 
schedule components perform actions at specified time points in a simulation.  
 
A simulation project can be refined by the application of Customization scripts. 
Customization offers the designer an all-purpose tool to model any imaginable aspect 
of a logical system by adaptation of the simulation engine for specific incidents in a 
simulation. 
 
This document contains a tutorial, which is intended to familiarize the user with the 
most important user interface items. The tutorial demonstrates the application of 
customization scripts and components and also introduces some commonly applied 
simulation modeling practices. 
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1.2 Tutorial 

This tutorial comprises construction and operation of a simple project for a small 
supermarket. The level of detail applied to the description of the required user actions 
presumes that the reader is familiar with the content of the Quick start guide section 
of this document. The tutorial demonstrates the application of some server and link 
properties and the interpretation of simulation results within a practical context. Also, 
it introduces the application of components to add random variation to the project and 
to store data in entities. In addition, it will explain how to refine the project by 
scripting. 
 
Imagine a supermarket where costumers arrive, spend some time shopping, choose 
a cash register, wait their turn, and then check out and leave. Suppose the manager 
of the supermarket would like to know more about how the number of cash registers 
affects the waiting time of the costumers for the check-out routine. This tutorial 
demonstrates how to go about in building a Renque project for the supermarket and 
extract this kind of information from it.  
 
Start the Renque application and create the project displayed in the figure, consisting 
of three active and a passive server object and five links. The server names are 
assigned by double-clicking a server and typing the desired text into the Name 
property text field of the Object properties console. 
 

 
 

The server named Arrival is both collection and dispatching, and has an open 
upstream link. The server will repetitively force the creation of an entity on the open 
link, store it for a specified period of time and then release it. As a result, it produces 
a flow of entities, with a release interval time determined by the Retention property of 
the server. These entities represent the customers arriving at the supermarket in the 
model. The customer entities released by the Arrival server are sent to the Shopping 
server where they are also stored for a specified time period. This delay represents 
the time spent shopping by the customers. The Shopping server dispatches the 
entities to the Queue server, where they will be stored until removed by the Checkout 
server. The Checkout server is used to implement the check-out process by 
application of another delay. Finally, the entities are sent to the open downstream 
link, which represents the departure of the customers from the establishment by 
destructing the entity. 
 
As discussed above, the Arrival server will release customer entities with an interval 
time equal to the Retention property of the server, which has a value 1 by default. In 
reality, the customer interarrival times at the supermarket will show random variation. 
The interarrival times of such processes are best described by an exponential 
probability density function. Renque is capable of generating random variation by 
means of distribution components.  
 
Creation of distribution components 
A distribution component that has the required exponentially distributed variation is 
created as follows: Open the Simulation properties console by the corresponding 
command in the Tools menu and select the Components tab at the top of the 
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window. Select and right-click the Distribution item in the repository on the left and 
select the New Distribution command in the context menu.  
 

 
 
This command creates a new distribution component, which appears as selected 
item in the Component repository. Change the Probability density function of the 
component by selecting the Exponential item in the drop-down menu. Keep the 
default value 1 for the Mean property. 
 

 
 
Following the same procedure, create another distribution component of type 
Triangular with properties (min, mod, max) = (1, 5, 24), which will be used for the 
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shopping time. The parameter values must be assigned in the reversed order: max, 
mod, min to prevent the interface from rejecting an invalid entry. 
 

 
 
These two distribution components can be assigned to timing-related object 
properties, such as the server Retention property. The component produces random 
numbers distributed in accordance with the component properties, using a built-in 
random number generator.  
 
The next step of this tutorial involves adjustment of server properties to obtain the 
desired behavior of the model. 
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Preparation of the Arrival server 
Return to the Workspace window, double-click the Arrival server and assign the 
Exponential distribution component to the Retention property on the Logic tab by 
typing the component name in the text field or pressing Ctrl+Tab key and selecting 
Exponential in the pop-up list. Press the OK button.  
 

 
 

You have assigned the distribution component named Exponential, of type 
Exponential, with parameter Mean = 1, to the retention property of the Arrival server. 
As a result, each entity stored in the server is assigned a randomly generated 
retention time value by the distribution component.  
 
Preparation of the Shopping  server 
Return to the Workspace window, double-click the Shopping server and Assign the 
Triangular distribution component to the Retention property of the Shopping server. 
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Also remove the Capacity limit of the server by clearing the associated text field on 
the Logic tab and check the Continuous collection option. 
 

 
 

With the Capacity limit removed and the Continuous collection enabled, the Shopping 
server can now process an unlimited number of customers simultaneously, which will 
be retained in the server for a period dictated by the Triangular distribution.  
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Preparation of the Checkout server 
The Checkout server represents the check-out routine. Double-click the Checkout 
server and type a value 0.9 in the Retention property text field.  
 

 
 
In reality the checkout time will also show random variation and there will be a 
correlation with the shopping time. However, a uniform checkout time is assumed for 
now. The value 0.9 renders the customer processing capacity at the check-out 10% 
higher than the average customer arrival rate, imposed by the mean value 1 of the 
Exponential distribution of the Arrival server retention property. Press the OK button. 
 
Finally, select all objects in the viewport, open the Object properties console, select 
the Logic tab, and check the Record statistics checkbox in order to activate 
statistics recording for the servers. 
 

 
 
Inspection of simulation results 
Before running the project a maximum run time is set for the simulation. We assume 
that the time unit for the project is minutes. Select the Clock tab in the Simulation 
properties console and enter the value 1200 (5 days) in the Time limit text field. For 
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the present project it in not necessary to select the Minutes value for the Time unit 
property.  
 

 
 
The simulation project for the supermarket, although still quite rudimental, is now 
ready to be run. Turn the animation mode on and press the Restart button. Watch 
the Shopping server initially filling up to some 10 customers, after which the first 
customers start arriving in the empty Queue to check out and leave. After running the 
project for a while the number of costumers shopping and queuing vary continuously.  
 
Turn the animation mode off and let the simulation continue until it stops. Select the 
Queue and Checkout servers in the viewport and select the Results tab in the 
Simulation properties console. On the Server results tab select Recorded statistics 
from the Data set pull-down menu. A data sheet appears containing the recorded 
statistics for the selected servers.  
 

 
 
In the Queue.Residence row of the data sheet, the column labeled Maximum reports 
a maximum residence time of 19.8 minutes. The reported Mean is 5.6 minutes. Also 
note that Checkout server is Occupied for about 92% of the time, as indicated by the 
rated item in the Checkout.Occupied row. 
 
Obviously, the queuing times observed will be unacceptable to the clients of the 
supermarket. The high maximum results from the high standard deviation of the 
exponential distribution applied to the Arrival server retention, which causes busy 
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next to quiet periods in the supermarket. As the check-out processing time is fixed, 
customers queue up during the busy periods.  
 
Model expansion 
The next step of the tutorial demonstrates how to increase the number of cash 
registers in order to reduce the customer queuing times. The simplest way to 
increasing the check-out server processing capacity is to increase the Capacity 
property value. However this method is unsuitable because each Checkout server 
has its own queue. Instead, select all server and link objects to the right of the 
shopping server. Then, while keeping the Ctrl key on the keyboard pressed, drag 
the Checkout server downwards with the left mouse button to duplicate the selected 
objects. After a simulation reset the result should look similar to this: 
 

 
 
Restart the simulation and let it run until it stops and inspect the results once again.  

 

 
 

As expected, congestion has been reduced significantly. A mean value of about 0.14 
minute and a maximum of a little over 2 minutes are reported for the residence time 
of the queue servers. The improvement is obtained at the expense of the Checkout 
occupation, which has dropped to 46% for both servers.  
 
The remainder of this tutorial focuses on refinement of the model with customization 
scripts to make the model more realistic. 
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Checkout time refinement 
The next exercise in this tutorial involves implementation of a checkout time that 
depends on the time spent shopping by a customer, with random variation. Create a 
new attribute component by selecting the New/Attribute item in the pop-up menu 
Component repository. Rename the new attribute TCheckout.  
 

 
 
An attribute component allows storage of data in individual entities. The attribute will 
be used to store a pre-determined checkout time for a customer into the entity that 
represents the customer. Select both Checkout servers in the viewport by dragging a 
rectangle from top-left to down-right enclosing only the two servers. Double-click one 
of them to open the Object properties console once again. Assign the new attribute 
component TCheckout to the Retention property of the selected servers by typing 
TCheckout into the Retention text field.  
  
Next, create a new distribution component of type Normal and keep the default 
parameter values. Double-click the Shopping server to open the Object properties 
console. Select the Custom tab and select the Dispatch  item in the Incidents table 
on the left side of the tab page. Type or paste the following script in the script editor 
area on the right: 
 
Normal.Parameter(1) = 0.1 5 * iEntity. Continuity  

Normal.Parameter(2) = (0.0 3 * iEntity. Continuity)^2  

Tcheckout = Normal.Evaluate  

 
This script changes the parameters of the Normal distribution component before 
being used to assign a generated random number to the Tcheckout attribute of the 
arriving entities. The entity Continuity function returns the residence time of the entity 
spent in the server, which is the shopping time. The Mean of the normal distribution 
(Parameter index = 1) is assigned a value proportional to the shopping time. Thus for 
each customer the checkout time will be a normally distributed random value with a 
mean of 15% of the shopping time spent by that particular costumer. On average, 
this is 1.5 minute because the mean shopping time is (1 + 5 + 24) / 3 = 10 minutes. 
The assigned value for the Variance (Parameter index = 2) results into a standard 
deviation of 20% of the mean value.  
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Queue routing refinement  
This section improves the mechanism for queue selection by the customers in the 
model. In the real supermarket we expect most customers to join the shortest queue 
when they arrive at the check out area. In the model the dispatch of entities from a 
server is governed by the Dispatch method of the server. Because the Shopping 
server has the default Cycle Dispatch rule, it sends released entities alternatingly to 
either queue.  
 
In order to obtain more appropriate behavior the dispatch routine is tweaked as 
follows: Double-click the Shopping server to open the Object properties console 
again. Select the Logic tab and select the value Random for the Dispatch method 
property in order to make the server randomly select a downstream link as target for 
an entity dispatched from the Shopping server.  Subsequently, select the Custom 
tab and the Dispatch select item in the Incidents table. Type or paste the following 
script in the script editor: 
 

if Queue. ResidentCount < Queue1. ResidentCount then  

iSelect  1 

elseif Queue. ResidentCount  > Queue1. ResidentCount then  

iSelect  2 

end if  

 

This script forces selection of the downstream link that connects to the destination 
server with the least number of residents. The ResidentCount  function of a server 

object returns the number of residents. The iS elect  procedure selects a link for the 

dispatch routine, overriding the prior link selection by the dispatch procedure. The 
arguments 1 and 2 denote the link connection number. The script is ineffective if both 

queues have an equal number of residents. In that case the random selection is 
preserved.  
 
Run the simulation again and look at the results. The reported mean queue 
residence time has grown to 1.3 minute with a check-out occupation of roughly 75%. 
The behavior of the queues in time can be reviewed on the Results sheet by 
selecting Recorded data in the Data set pull-down menu, after activation Population 
item on the Record data pull-down menu of the Object properties console. The chart 
below was obtained by copy/paste of the recorded population data for the Queue 
servers to Microsoft Excel. It shows that the queue population patterns do not differ 
much in time. 
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Conclusion 
Simple as it may seem, the tutorial project for the supermarket is quite realistic. The 
data applied to the project parameters are fictitious, though. In order to reach a 
usable level of accuracy, these parameters need to be derived from data acquired 
from observations in the real supermarket or from suitable estimation methods. 
 
One conclusion that the manager might come to by using the simulation is that 
substantial cash register overcapacity is required to prevent losing clients to 
competitors on frustration about long waiting times. One obvious strategy to increase 
employee utilization is to assign cash register operators to other duties during quiet 
periods, such as shelf stocking.  
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2 The Renque workspace 

Renque simulation models are constructed and operated in the workspace window. 
The workspace window is the principal user interface of the application. It is opened 
when the application is started, and the program exits when the workspace window is 
closed. 
 

 
 
This section starts with a discussion of the general properties of the application and 
has separate topics for each of the elements of the workspace window: 
1. Viewport  Displays the Renque working environment. 
2. Link toolbox Contains templates for link creation. 
3. Server toolbox  Contains templates for server creation. 
4. Menu bar  Categorized list of commands. 
5. Toolbar  Provides access to frequently used menu items. 
6. Simulation toolbar Controls simulation operation, animation and displays 

information on the state of a simulation. 
7. Status bar  Displays the current layer of the viewport and controls 

edit options. 
  
Additional particularities of the behavior of the workspace are given in topics: 

¶ Layers 

¶ Blocks and fusions 

¶ Curve types 

¶ Viewport pages 
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2.1 Application properties 

Renque is a stand-alone application. Multiple instances of Renque may be started in 
the operating system, but you can only operate a single project in a Renque instance. 
Most elements of a Renque project may be copy-pasted between Renque instances 
by the standard methods of the operating system. 
 
Projects are opened and saved by the usual commands New, Open, Save and Save 
As, which are available in the File menu of the Main window. Double-clicking a file 
with a Renque-associated file extension in Windows Explorer will open the file in a 
new Renque instance. Drag-dropping a file from Windows Explorer onto the viewport 
area of the Main window will open the file, after prompting to save the project being 
replaced. A Renque instance is closed by the Exit command on the File menu or by 
clicking on the óXô-button on the title bar of the Main window.  
 

Renque project file types 
There are three Renque project file types: 

¶ The Renque project file (extension: *.rnqp, icon:  ) 

¶ The Renque server toolbox file (extension: *. RenqueServerToolbox, icon:  )  

¶ The Renque link toolbox file (extension: *. RenqueLinkToolbox, icon:  )  
 
The Renque project file is the standard Renque project file type. This file type 
supports storage of all information that can be contained in a Renque simulation 
project, including bitmaps and all simulation data.  
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2.2 Viewport 

A Renque simulation project is constructed and operated in the viewport area. It 
supports the following operations, using the mouse, the Menu bar, the toolbar, or the 
context menu on the viewport: 

¶ Add and delete servers and links. 

¶ Cut, copy & paste servers and links. 

¶ Group/Ungroup objects. 

¶ Merge objects into Blocks and Fusions. 

¶ Rearrange servers. 

¶ Resize and edit servers. 

¶ Edit link curves and change link connections 

¶ Change the display order of servers. 

¶ Assign an object layer. 

¶ Create and deleted link templates and server templates 

¶ Operate simulations  

¶ Create a page background 
 

Server creation 
Servers are added to the model by drag-dropping a template from the Server toolbox 
onto the viewport, using the mouse. Server objects added to the viewport are placed 
in the Active layer. 

Link creation 
Links are created by selecting a link template from the Link Toolbox and clicking with 
the left mouse button successively on the desired origin and a destination server of 
the link. If the mouse hovers over a connectable region of a server, the possibility for 
a creating a link connection is indicated by a change of the mouse cursor. The 
connection location is indicated by a diamond symbol. Open link ends can be created 
by clicking anywhere on the viewport while pressing the Ctrl-key. The curve type is 
determined by the selected Curve type item in the Format menu. The path of a curve 
is determined by control points, which are visible only when a curve is being edited or 
created. Each click on the viewport adds a control point to the link curve. Link objects 
created on the viewport are placed in the Active layer.  

Object selection 
The selection state of servers and links is indicated in the viewport by the display of a 
semi-transparent mask over the object in the selection color of the operating system.  
 
Selection of a single object is simply done by clicking on it in the viewport. The 
selection result depends on the state of the Ctrl key and the Shift key on the 
keyboard during the selection operation. 
 

Shift key state Ctrl key state Selection result 

released pressed remove from selection 

pressed released add to the selection 

released released start new selection 

 
To select/unselect several objects at the same time: Click with the left mouse button 
on an empty location on the viewport and move the mouse while keeping the mouse 
button pressed. A rectangle is displayed to indicate the active region. The selection 
operation is executed when the mouse button is released. The result of this 
rectangular selection depends on the horizontal sweep direction. If the mouse was 
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moved from left to right, only objects that lie completely inside the rectangle are 
affected. If the mouse is moved from right to left objects touching the rectangle are 
selected as well. The effect of pressing the Ctrl and Shift keys for to this selection 
method is the same as for selection of single objects by mouse clicks.  

Object rearrangement and duplication  
The position of servers on the viewport can be changed by dragging their icon across 
the viewport. If the control-button on the keyboard is pressed while starting the drag 
operation, the selected servers and selected connected links are duplicated, in which 
case the duplicates are subjected to the drag operation. As opposed to the 
copy/paste menu commands, duplication does not store the objects in the clipboard 
of the operating system. 

Object editing 
The Edit objects command of the Edit menu toggles the edit mode for selected 
objects in the viewport. In the edit mode, sizing handles are displayed on the edges 
of the server icon bounding box. In addition, the control points of the server and link 
residents curves are displayed. For symbols, the edit mode also displays sizing 
handles for the symbol text area and control points for the symbol curve. The sizing 
handles and control points can be selected with mouse operations in the same 
manner as objects on the viewport. The selected items can be dragged with the 
mouse in order to modify the object. Control points can be duplicated by dragging a 
selected control point while keeping the Ctrl key pressed. Pressing the Del key 
removes the selected control points of the curve. The curve type is set by selecting 
the corresponding Curve type item in the Format menu. Links can be detached from 
connected servers by dragging the end point away from the server. Reversely, links 
can be attached to a server by dropping the end point on a suitable connection point 
of a server. The connection point is indicated by a marker in the shape of a diamond. 
A vertical line in the circle distinguishes the end point of resident and link curves from 
the start point. A polygon or spline curve with more than two control points is 
reshaped if one of the end points is dragged on the viewport. The space bar must be 
pressed to change only the end point location. The link tag location is denoted by an 
encircled cross sign. Pressing the Esc key terminates the edit mode without storing 
any changes made to the selected objects. 

Viewport transformations 
The viewport may be scaled and translated using the mouse. The viewport is 
translated if the mouse is moved while keeping the right button pressed. The 
viewport is dynamically scaled if also the Ctrl key is held down.  

 
The viewport may also be scaled by the Extend viewport command on the 

View menu and by the Zoom button on the Toolbar. The Zoom button enables 

scaling to a region specified by dragging the mouse. If the mouse is dragged in the 
Viewport after pressing the zoom button, a rectangle is drawn of the same aspect 
ratio as the Viewport, centered around the mouse-down location. The size of the 
rectangle corresponds to the viewport scaling factor applied when the mouse button 
is released. The scaling direction depends on the direction of the mouse 
displacement. If the mouse was moved from to the right the viewport scale range is 
decreased to the rectangle area scale range. If the mouse button was moved to the 
left, the viewport is expanded to the range that results from shrinking the Viewport 
area into the rectangle area. For a small mouse displacement, the viewport scaling 
factor remains unchanged and the center of the viewport is translated to the mouse 
location. 
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2.3 Toolboxes 

Toolboxes are used to create objects in the viewport. There is a toolbox for link 
templates (Item 2 in the figure) and a toolbox for server templates (Item 3 in the 
figure). The toolboxes may be hidden by unchecking the Toolbox item on the 
View menu. 
 

 
 

The toolboxes contain one or two default templates. Server and Link objects in the 
viewport can be stored as new template in the toolbox by the Create template 
command from Format menu or the context menu of a selected object. A new 
template inherits all properties from the source object. Templates properties cannot 
be changed.  

Link toolbox 
The link toolbox contains link templates. Links created on the viewport inherit all 
properties from the selected template in the link toolbox. 

Server toolbox 
The Server toolbox (Item 3) contains server templates. A new server is created by 
dragging a template from the toolbox and dropping it on the viewport.  

2.3.2 Toolbox properties 

The template icons in the toolbox can be rearranged by drag-drop mouse operation.  
The toolbox properties can be modified by commands of the context menu of the 
toolbox. Besides the standard Cut , Copy, Paste and Delete items, the Toolboxes 
have the following context menu item: 

¶ Add category Creates a new category for template categorization. 

¶ Incrm. col. count Adds a column for template organization in columns. 

¶ Decrm. col. count Removes the right-most column. 

¶ Select children Selects all viewport objects created by the selected 
template. 

¶ Properties Opens a window which allows modification of the toolbox 
properties. 

¶ Config/Write Saves the toolbox properties and content to disk. 

¶ Config/Read Reads the toolbox properties and content from disk. 

¶ Config/Import Adds toolbox content from disk to the present configuration. 

¶ Config/Restore Restores the default set of Toolbox templates. 
 



 Renque user's guide 

- 27 - 

2.4 Menu bar & Toolbar 

The Menu bar is located right underneath the title bar of the Main window. It has a 
series of commands grouped into drop-down menus. The most frequently used Menu 
bar commands are also available as a button on the Toolbar, which is located under 
the menubar.  
 
The Menu bar commands are listed below, together with the corresponding Toolbar 
button icon, if existing, and a brief description of their function. 
 

File menu 

 New Starts a new project and discards the current. 

 
Open project Opens a project file. 

 
Save project Saves the current project. 

 Save project as Saves the current project after prompting for a file 
name. 

 Page setup  Opens the Page setup selection menu. 

 Print Prints the project to a printer. Requires completed 
page setup.  

 Exit Closes the application without saving. 

 

Edit menu 

 
Undo Undo the last mutation to the project. Clicking on the 

drop-down arrow opens a mutations list to select an 
item from. 

 
Redo Redo the last undone mutation to the project. 

Clicking on the drop-down arrow opens a list of 
undone mutations to select an item from. 

 Repeat Toggles the Repeat mode for object creation 

 
Cut Removes selected objects from the viewport and 

stores them in the Windows clipboard. 

 
Copy Copy the selected objects the viewport to the 

Windows clipboard. Also available as pop-up 
command on the viewport. 

 
Paste Paste objects from the Windows clipboard to the 

viewport. Also available as pop-up command on the 
viewport. 

 
Delete Delete objects selected in the viewport. 

 Edit objects Toggles the viewport object editing mode 

 Editor display options Locks/Unlocks specific object display elements  

 Find  Opens the Search utility to select servers by string 
comparison. 

 Select Selects specific object types in the viewport. 

 Unselect Unselects specific object types in the viewport. 
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View menu 

 Animation preview Toggles the Animation preview display mode 

 
Extend viewport scale Rescales the viewport to fit the entire model. 

 Scrollbars Determines when the viewport scrollbars are 
displayed. Selecting the Auto option displays the 
scrollbars only if the model does not fit into the 
viewport. 

 Toolbox Hides the Toolbox when unchecked. 

 Toolbars Hides a specific toolbar when unchecked. 

 

Run menu 

 
Reset Resets the simulation run, discarding all simulation 

data. 

 
Restart Starts a new simulation run, discarding all simulation 

data of the current run.  

 
Pause Pauses or resumes the current simulation run.  

 
Animation Toggles animation on and off. 

 End replication Ends the current replication, preserving all 
replication data. 

 Reset replication Resets and discards all data of the current 
replication.  

 

Insert Menu 

 Upstream open link Adds a open upstream link to all selected servers on 
the viewport. Also available as pop-up command on 
the viewport. 

 Downstream open link Adds a open downstream link to all selected servers 
on the viewport. Also available as pop-up command 
on the viewport. 

 

Format Menu 

 
Align Allows alignment of selected server objects. 

 Order Allows adjustment of the server z-order 

 
Group objects Joins the selected objects in the viewport into a 

group, forcing subsequent joint selection of all group 
members.  

 
Ungroup objects Breaks up all selected groups in the viewport. 

 Curve type Controls the curve type for new links and for curve 
editing. 

 Blocks Manages blocks and fusions. 

 Swap link name Swaps the name properties of two selected links 
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Transform menu 

 Make symbols equilateral Adjusts the aspect ratio of selected symbols to 
render polygons equilateral and ellipses circular 

 Reset symbol text size Adjusts the text area of symbols to fill the symbol 
shape 

 Insert page reference Inserts a page reference symbol pair on the selected 
links. 

 Remove page reference Removes the selected page reference symbol pairs. 

 Create templates Creates a template in the toolbox for the selected 
viewport objects. 

 

Tools menu 

 Object properties Opens the Object properties console, as will double-
clicking the viewport. 

 Simulation properties Opens the Simulation properties console. 

 Pictures Opens the Picture management console. 

 Layers Activates the Layer control panel.  

 Page background editor Opens the background editor window. Requires a 
completed Page setup procedure. 

 Preferences  Opens the Preferences utility to change preference 
settings of the application and the project. 

 
 

Window menu 

 Background Changes the background color of the viewport. 

 Arrange windows Opens the Window arrangement utility. 

 Windows list  Presents a list of all open window titles. Clicking on 
an item in the list activates the window.  

 

Help menu 

 Getting started Opens the Getting started section of the help 
document.  

 Renque help Opens the help document. 

 Renque website Opens the Renque website in the default internet 
browser. 

 Check for updates Connects to the internet and checks if a more recent 
Renque release is available for download. 

 About  Displays the application identifier panel. Click the 
panel to close it. 
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2.5 Simulation toolbar 

The simulation control toolbar is located under the viewport. The main simulation run 
commands Reset, Restart, Pause  and Animate of the Run menu are also available 
as control button on the simulation bar, together with some additional controls and 
simulation state indicators.  

Simulation run buttons 
The Reset button resets the current simulation run and discards all simulation data. 
The Restart button starts a new simulation run. The Pause button toggles between 
the paused and running simulation state.  

Animation  
The Animation button toggles animation on and off. 

Animation speed 
The Animation speed slider controls the animation speed. Moving the indicator to the 
left increases the animation speed. The speed range is adjustable by the 
Speed control range extent item on the Simulation properties console. 

Animation preview  
The Animation preview button toggles the animation preview display mode. If a 
simulation is running, the display style of objects on the viewport is determined by the 
server animation properties and link animation properties. Animation preview applies 
the animation display style of the viewport when the simulation is not running. 

Simulation state pane 
The Simulation state pane is the text area to the left of the Animation preview button. 
It reports the sequence number and state of the current replication. The text in this 
panel colors red if the simulation has a runtime error. 

Simulation time panel 
The Simulation time panel is the rightmost control on the Simulation control toolbar. 
The simulation time panel reports the current simulation time in a user-specified 
format.. A mouse click on this panel activates a text edit field for the Time display 
format string. 
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2.6 Status bar 

The Status bar is located at the bottom edge of the window and is divided into 
panels, as indicated in the figure.  
 

 
 

Layer pane 
The Layer pane (Item 1) displays the object layer of selected objects on the viewport, 
or the Active layer if no objects are selected, Clicking the layer panel activates the 
Layer control panel.  

Mouse location panel 
The mouse location panel (item 2) displays the mouse x/y-coordinates on the 
viewport 

Viewport options panel. 
The viewport options panel (item 3) contains two toggle buttons. The Grid button 
toggles the display of the Page grid. The BKGND button toggles the display of the 
viewport Page background.  

Object snap panel 
The object snap panel (item 4) contains a set of four toggle buttons, which aid 
precise positioning  of objects on the viewport. The Grid snap button enables 
snapping to the viewport page grid. The Edge snap button enables snapping of 
server edges end link end points. The Ortho button enables preservation of vertical 
or horizontal coordinates of objects. The Drag THR button enables application of a 
threshold distance for mouse drag operations, in order to prevent unintentional 
displacement of objects by small mouse movements.  
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2.7 Layers  

The server and link objects on the viewport are organized in layers. The layers have 
a specified color, and may be locked and hidden. The main purpose of layers is to 
cluster objects that are related in some meaningful way, for example by a common 
function in the model. The organization of a project into layers offers many 
advantages to the project designer. The ability to hide layers and to apply different 
colors to layers makes it easier to visually distinguish objects in the viewport. Objects 
in locked layers cannot be selected in the viewport. 
 

Active layer 
New objects created on the viewport are placed in the layer that has been assigned 
active layer. The active or current layer can be identified in the Status bar and by the 
color of the default templates in the Toolbox.  

Layer control panel 
The layers of a Renque project are managed by the Layer control panel, which is 
activated by a mouse click on the left-most panel of the Status bar or by the Layers 
command of the Tools menu. The Layer control panel is a pop-up control that 
presents a list of all layers defined for the project. It enables the creation and deletion 
of layers, modification of layer properties, and assignment of the current layer. It is 
also used to place objects on the viewport in a different layer.  
 

 
 
The column labeled Name displays the layer name. The layer name can be edited in-
cell, by double clicking the name field or by pressing a key on the keyboard. The 
assigned name must be unique and has the same format requirements as the Name 
property of servers, links and components. The column labeled Color determines the 
default display color for objects contained in the layer. A click on the Color column 
activates a color selection dialog. The radio button in the third column identifies the 
Active layer of the viewport. The two other columns present additional layer 
properties indicated by an icon. The cross-out icon signifies that the layer is hidden. 
The padlock icon signifies that the layer is locked. A mouse click on either of the two 
leftmost columns toggles the corresponding layer property.  
 
The Set object layer button appears on the Status bar when the Layer list is 
activated. By pressing this button, all selected server and link objects on the viewport 
are placed in the selected layer in the Layer list. New layers are created by the Add 
layer command of the context menu of the layer list. The Del key deletes the 
selected layers in the Layer list. 
 
While the layer panel is visible, the window's Menu bar & Toolbar are disabled, as 
are all other windows of the application. The Layer tool is deactivated by clicking on 
the viewport, or pressing the Escape key on the keyboard. 
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2.8 Blocks and fusions  

Blocks and fusion are named groups of objects that act as a single object. You can 
use them to create repeated model content and represent hidden model sections. 
They can help you save time and make your model more easy to view. Block and 
Fusion servers can be stored as server templates in the Toolbox. 

Blocks 
A set of server and link objects selected in the viewport can be joined into a block 
server. A block server represents the block members collectively by a single server in  
the viewport. The constituents of the block server cannot be selected, rearranged, 
edited or modified. Links can still be connect to the individual servers contained in a 
block.  
 
The Create block command of the Block Format menu merges all selected objects 
on the viewport, including block servers, into a new block server. The Explode block 
command reverses this transformation for all selected block servers on the viewport. 

Fusions 
The Fuse blocks command of the Block Format menu transforms the selected block 
servers in the viewport into fused block servers. Fused block servers are useful to 
represent a section of a project by a single server object. The default icon of a fusion 
server has the same style as the default template icons in the Toolbox.  
 

 
 

A link that is connected to a fused server, but not fused itself, is shown as connected 
to the fusion server in the viewport. Links can be connect to a predetermined 
destination or origin server contained in a fusion. The Unfuse blocks command 
transforms all selected fused block servers back to a regular block server. 

Fusion window 
A fused block server may be displayed in a separate Fusion window. The Open 
fusion window command of the Block Format menu opens new fusion windows for 
all selected block and fusion servers in the viewport. The fusion window is identical to 
the Workspace window, but does not have the File menu and some items in the Help 
menu. The fusion window permits modification of the block server by the same 
methods used in the viewport of the workspace window and supports all simulation 
animation features. Changes made to the Layer control panel and the simulation 
control toolbar of the workspace window and fusion windows apply to all open 
windows. The Close block window command closes the block windows for all 
selected block servers in the viewport. 
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2.9 Curve types 

The shape of a link curves in the viewport is determined by the curve format type and 
a series of control points. Renque supports the curve types Orthogonal, Polygon and 
Spline.   
 

 
 
The curve types exist for display purposes only: they have no logical distinctions in a 
model. The curve type of a link is determined by the Curve type item in the 
Format Menu. Curve control points can be added, removed and rearranged In the 
edit mode of the viewport. 
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2.10 Viewport pages 

Completion of the Page setup dialog of the File menu divides the viewport into 
pages. The specified page properties may be reviewed by the Page properties item 
of the Preferences console 
 

Page grid 
The Grid size item of the Preferences console allows definition of a page grid as 
reference for the arrangement of objects on a page.  The page grid is only shown on 
viewport pages that have at least one server or link object. The grid can be hidden by 
the Grid button on the Viewport options panel. 

Drawings 
Each page on the viewport represents a drawing. The properties of a drawing are 
specified on the Specs tab of the Object properties console.  

Page background 
The Page background editor item on the Tools menu opens the background editor 
console. The page background is drafted in the viewport of the background editor as 
is the simulation model in the Workspace window, but cannot include link objects. 
The page background is displayed on every page of the workspace viewport. The 
properties of individual drawings can be expressed by Viewport object text codes for 
server objects in the background. The page background can be hidden by the 
BKGND button on the Viewport options panel. 

Page reference servers 
A page reference server pair presents a method to systematically arrange page 
crossing links. A link is transformed into a page referencing link by the 
Insert page reference item of the Transform menu. This transformation spits the link 
into two parts on the viewport, each connected to a newly created page reference 
server. The page transition is depicted by placing each page reference server on the 
matching source or destination page of the original link, which will consequently be 
represented on both pages by either of the two split parts.  
 

 
 
The page reference servers have no logical function in the simulation and the two link 
parts both represent the transformed link in the simulation. Animation of entities on 
the link is duplicated to both link parts. The page location of the page reference 
servers can be expressed by Viewport object text codes. The page reference 
construction is removed from a link by the Remove page reference item of the 
Transform menu.  
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3 Object properties  

The Object properties console provides access to properties of viewport objects, 
drawing properties and properties of the of project itself. The object properties 
console is opened by the Object properties command on the Tools menu or by 
double-clicking the viewport.  
 

 
 
The main tab strip at the top of window determines the object type for which 
properties are displayed. The secondary tab strip below the main determines the 
property category. This section is organized by the items of the secondary tab strip.  

Viewport context 
The window can be opened from the Workspace window and from a Fusion window. 
The window from which the console is opened represents the viewport context of the 
console. The console only displays properties of server and link objects that have the 
selected state in the viewport. If the selected objects do not have a uniform value for 
a specific property check boxes are grayed out, and combo boxes are left empty. 
Text fields are left blank or in case a blank field represents a specific value the 
keyword <various> is displayed. In general, control items on the console are disabled 
or hidden if there are no selected server objects that are affected by the controlled 
property. Alteration of object properties by the control items on the console is applied 
to all selected objects.  
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3.2 Specs 

The Specs tab on the Object properties console presents general properties of the 
project and selected servers, links and drawings 
 

 
 

Type name 
The Type name property may contain a maximum of 255 characters in the ranges A-
Z, a-z, 0-9 and the underscore _ symbol. The property must start with an alphabetic 
character. The type name must be unique to the object type and is case-insensitive. 

Index 
The index property of an object in an integer number >0. The name of an object 
consists of the above-mentioned type name followed by the non-zero index value. 
The name of each object is unique in the project. When the index property is 
changed, indexing of the selected objects starts with the specified value, where the 
index value of non-selected objects with the same type name are skipped. The 
default tag property of an object is the type name followed by a space and the non-
zero index. 

Description 
Descriptive text for the item. 

URL attachments 
Displays a list of attached URL's to the selected viewport object, drawing or the 
project. 
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The Add item command of the context menu of the list adds a new untitled blank 
URL attachment to the list. The Edit name context menu command activates the edit 
mode of selected cell in the name column, as does pressing the space bar. The Edit 
URL context menu command activates the edit mode of selected cell in the URL 
column. The Browse file command allows opens a file selection dialog for 
assignment of a file URL to the selected item in the list. The Show in folder 
command opens a file URL in the system file browse. A double-click on the list 
opens the URL of the selected item with the appropriate system application.  
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3.3 History 

The Revision tab on the Object properties console presents revision information of 
the project and of the drawings in the project. 

Revision 
Displays the revision number of the project or the selected drawings in the project. A 
drawing is selected if any of the viewport objects in the drawing are selected. The 
project revision number is the maximum of all drawing revision numbers. The text 
field is read-only. The revision number is displayed in bold if a revision increment is 
due because of modifications made to an object on a drawing since the last revision 
increment, including changes that are not visible on the drawing.  
 
The revision numbering method is controlled by the revision control item in the 
project preferences. For the manual revision control method the revision number may 
be incremented manually by the Increment command of the context menu of the text 
field. The increment is applied to all selected drawings on the Drawing tab or to all 
drawings if the Project tab is selected.  
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3.4 Display 

The Display tab on the Object properties console presents the display properties of 
servers and link objects.  

 

3.4.1 Server format 

 

Icon 
Determines the server icon property. Type the name of the desired picture object or 
select it from the combo box.  

Width 
Determines the width of the server in the viewport. The value is specified in the units 
defined by the Units preferences. 

Height 
Determines the height of the server in the viewport. The value is specified in the units 
defined by the Units preferences. 

Symbol 
Determines the display method of servers on the viewport. If the value <None> is 
selected a server is represented on the viewport by the bitmap selected for the 
above-mentioned icon property. For other values for the symbol property the server 
is represented by constructed symbol. The selected value determines the base 
shape, which can be a ellipse or a polygon. The symbol can be filled or transparent, 
and can have a border, a curve, and a picture. A symbol can also be rounded and 
rotated. 
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3.4.2 Symbol appearance 

 

Tilt 
Tilts the symbol by 90 degree angles.  

Fill style 
Determines the fill style of the symbol. A click on the adjacent button opens a color 
section dialog that allows selection of the fill color. For the two Gradient values a 
second color button appears which represents the secondary gradient color.  

Picture fit 
Determines the arrangement of the server icon in the symbol. Possible values are 
<None> (not shown), Center (centered without size change), Stretch (stretched to fit 
the symbol with preservation of aspect ratio), Fill (stretched to fill the symbol), Tile 
(Repetitive tiling from top-left corner, cropped at left and bottom edges), Shrink 
(center and if larger than the symbol: stretch) 

Rotation 
Determines the clockwise rotation angle of the symbol in degrees.  

3.4.3 Symbol border 

 

Style 
Determines the border line style. A click on the adjacent button opens a color section 
dialog that allows selection of the border color. 

Width 
Determines the border width specified in mm.  

Rounding 
Determines the corner rounding of the border within a range of 0 - 100%  
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3.4.4 Symbol curve 

 

Style 
Determines the curve line style. A click on the adjacent button opens a color section 
dialog that allows selection of the curve color. 

Width 
Determines the curve width specified in base units. The value Hairline represents the 
smallest value for the resolution of the selected printer.  
 

3.4.5 Link arrow properties 

 

Arrow size 
Determines the distance of the arrow hand tip to the edge of the link curve, specified 
in mm. 

Rel. length 
Determines the length of the arrow as fraction of the above-mentioned size property. 

Fill extent 
Determines the length of the solid arrow area along the curve as fraction of the 
above-mentioned relative length property 

Solid line 
Forces a solid line for the arrow outline for dotted and dashed curve styles  

Serial 
Determines whether or not arrow display is repeated for every curve segment of a 
segmented curve. 

3.4.6 Link curve 

 

Style 
Determines the curve line style. A click on the adjacent button opens a color section 
dialog that allows selection of the curve color. 
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Width 
Determines the curve width specified in mm. The value Hairline represents the 
smallest value for the resolution of the selected printer.  

Tag seat 
Determines the position of the tag location on the link curve in the range 0 - 1, where 
1 denotes the destination location. 
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3.5 Text 

Scope 
The scope frame determines which properties are referenced by the other controls 
on the tab. The listbox on the right contains a list of all server of link objects selected 
in the Viewport context. The tab references all objects selected in the listbox. 
Checking the Individualize item enables the listbox, which allows selecting the 
individual items in the listbox. Selecting the Symbol text option (not available for 
links) changes the scope to the text displayed in symbol servers instead of the object 
Tags (default). 

Text 
Determines the actual text displayed. Multiple lines are allowed. The displayed text is 
managed by a set of text codes. Any combination of display codes can be used. 
Symbol text also recognizes clock display codes. Characters that do not represent a 
code are displayed as literal text. 

Font 
A click on the Font text field opens a Font selection dialog, which allows defining 
the text font properties. Note that for symbol text the font size is specified as 
percentage of the extent to fit the text region in the symbol. Clicking the adjacent 
color selection button opens a dialog for selection of the text color. A click on the 
color button while pressing the Ctrl-key assigns the layer color to the text color. A 
click on the color button while pressing the Shift-key assigns the viewport foreground 
color to the text color.  

Hide 
Hides the text in the viewport 

Alignment 
Determines the horizontal text alignment. Possible values are Left, Center and Right. 

Placement 
Determines the vertical text alignment. Possible values are Top, Middle  and Bottom. 

Line spacing 
Determines the line spacing of the text display in the viewport, as fraction of the 
standard line spacing. Any floating point  

Rotation 
Determines the clockwise rotation angle of the link tag in degrees. An empty value of 
the text filed denotes alignment of the tag with the curve at the Tag seat location. Not 
available for servers. 
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3.6 Routing 

3.6.1 Link connection options 

 

Refuse all connections 
If checked, links cannot be connected to the server.  

Auto arrange 
Determines the method by which link connections are organized. If checked, new link 
connections are snapped to the server edges in a uniformly spaced arrangement. If 
unchecked new links can be connected to any location on the server. Changing the 
value of the Auto arrange property does not affect existing link connections 

Refuse picture knots 
If checked, link connections cannot be snapped to picture knots of the server icon.  

Refuse knot on symbol text 
If checked, link connections cannot be snapped to the outline of symbol text.  

Outset edge knots 
If checked, links connections are shifted away from the server edge by half the curve 
width, such that the connected link curves do not overlap with the server icon.  

3.6.2 Auto arrangement options 

Determines the arrangement of link connections under application of the above-
mentioned Auto arrange option. The control has three properties, organized in 
columns for the four sides of the server icon as indicated in the first column.  The 
Max. knots column determines the maximum number of permitted connections for 
each side. The value can be set by clicking the corresponding cell and typing the 
desired number. An empty field denotes that there is no limit to the number of 
connections. The check boxes in the Static column denote that the link connection 
spacing is predetermined in accordance with the specified Maximum knots value, 
independent of the number of connections. If checked, links can only be connected to 
a free position on the edge. The Spacing column determines the spread of the 
connections on the edge. A value between 0 and 1 can be specified, which denotes 
the relative length of connected section of the edge.  

Connections 
The connections frame contains a list of all connections of the selected server or link 
objects.  
 

 



 Renque user's guide 

- 46 - 

 
The listbox has 5 columns. The center column shows the name of the selected 
object. The two outer columns display the names of the connected origin and 
destination servers for links or the names of the connected links on both sides for 
servers. The two columns labeled Conn. on either side of the center column display 
the sequence number of the server for the connection. The display style of the 
connection number indicates the Collect method for an upstream link or the Dispatch 
method of a downstream link. The sequence number in the set of elective link 
connections is indicated between parentheses if the link is Elective. The sequence 
number is indicated in the color green if the link is Mandatory/Escort or in purple if the 
link is Resource/Discard. The names of selected objects are displayed in the system 
selection highlight color in the two outer columns.  
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3.7 Logic 

3.7.1 Server operational properties 

The Operational properties frame displays server properties that determine the 
behavior in a simulation. The frame displays the initial reset-state value of these 
properties. The current value in a simulation is presented on the Runtime tab. 

Priority 
Determines the Priority value of calendar events generated by the server. Permitted 
values are integer numbers in the range -32765 to +32765.  

Capacity 
Maximum number of residents allowed in a server. Permitted values are integer 
numbers >= 0. The Capacity property is set to Nil if the text field is left empty, which 
means that the server has no capacity limitation.  

Retention 
Determines the storage time for entities in servers. Permitted values are floating point 
numbers >= 0 and all evaluating component types. The Retention property is set to 
Nil if the text field is left empty, which means that the entity is stored for an unlimited 
period of time.  

Disabled 
Disables the server. A disabled collecting server does not collect entities and a 
disabled non-collecting server cannot receive entities.  

Continuous collection   
By default, a completed collect operation is restarted when the last resident leaves 
the server. Application of this option restarts a completed collect operation upon 
completion of the Transfer routine.  

Collect method 
Determines whether or not a server is collecting and specifies the selection method 
of an Elective link by the verification routine of a collecting server. Possible values: 
None (Server is non-collecting), Cycle (test links in top-down order, starting from the 
previously selected link); Random (random choice); Successive (test links in top-
down order, starting from the top link); Reversed (test links in bottom-up order, 
starting from the bottom link).  

Dispatch method 
Determines whether or not a server is dispatching and specifies the selection method 
of an Elective link in the dispatch routine of a dispatching server. Possible values: 
None (Server is non-dispatching), Cycle (test links in top-down order, starting from 
the previously selected link); Random (random choice); Successive (test links in top-
down order, starting from the top link); Reversed (test links in bottom-up order, 
starting from the bottom link).  

Provide method 
Determines the selection method for a resident entity provided by a non-dispatching 
server for collection by a downstream connected collecting server. The dropdown 
menu offers the values FIFO (first-in-first-out), LIFO (last-in-first-out) and Random 
(random choice from the resident entities).  

3.7.2 Server animation options 

Hide: residents; curve; resident count; label; icon 
Hides the indicated items in Animation.  
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Animate instant removal 
Ensures that an animated resident entity is visible in animation for at least the 
Instantaneous travel display time. The option is ineffective if the above-mentioned 
Hide residents option is applied 

Show curve jutting resident 
Resident icons are displayed on the server curve by default only if the icon fits 
completely on the curve. If applied, the first resident icon is displayed even if it 
doesn't fit on the curve.  

3.7.3 Server data 

Record data 
Activates or deactivates data recording for the server for one or more properties. 
Deactivation clears all recorded data. 

Record statistics 
Activates or deactivates statistics recording for the server. Deactivation clears all 
recorded statistics. 

Skip instant change stats 
Excludes zero duration observations from the statistics recording for the server. If 
applied, multiple identical states, intermitted only by instant changes, form a single 
continuous observation.  

Server status by collection  
Determines the status recording method for collecting servers. Application of this 
property activates the Idle/ Busy status, for which a collecting server assumes the 
Idle status when the collect operation has been halted by the verification routine. The 
Busy status is assumed when verification is complete. The property does not affect 
non-collecting servers and the Disabled status. 

3.7.4 Link operational properties 

The Operational properties frame displays link properties that determine the 
behavior in a simulation. The frame displays the initial reset-state value of these 
properties. The current value in a simulation is presented on the Runtime tab. 

Batch size 
Number of entities to be collected on the link by a collecting destination server. 
Permitted values are integer numbers >= 0.  

Travel time 
Duration of the entity travel on the link. Permitted values are floating-point 
numbers >= 0, the value Nil and all evaluating component types. The value Nil 
signifies instantaneous travel. 

Initializing 
Enables entity creation on an upstream link at the start of a simulation replication 
before statistics recording commences. If applied, a number of entities equal to the 
Batch property of the link are created. The initializing entities are relocated to the 
destination server without travel on the link. The entities are dispatched immediately 
if the server is dispatching, or processed by the Entity reception procedure if the 
server is not dispatching. 

Completing 
Enables entity creation on a link for entity retrieval. The link will create as many 
entities as required to complete entity transfer through the link, even if the link is not 
an open link. 
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Collect method 
Determines the role of the link in the verification routine of the destination server. The 
drop-down menu offers the values Elective (link subjected to selection by the 
Collect method of the destination server), Mandatory (link excluded from selection) 
and Resource (link excluded from selection and collected entity processed as 
resource).  

Dispatch method 
Determines the role of the link in the Dispatch routine of a dispatching origin server. 
Possible values are Elective (link subjected to selection by the Dispatch method of 
the origin server), Escort (link receives a copy of the dispatch entity) and Discard (link 
receives discarded entities). If more than one dispatching links of a server have the 
Discard value, only the top link is effective as discard link.  

3.7.5 Link animation options 

Hide: residents; curve; travels 
Hides the indicated items in Animation.  

Animate instant removal 
Ensures that an animated link resident is visible in animation for at least the 
Instantaneous travel display time. The option is ineffective if the above-mentioned 
Hide residents option is applied. 

Show curve jutting entity 
Resident icons are displayed on the link curve by default only if the icon fits 
completely on the curve. If applied, the first resident icon is displayed even if it 
doesn't fit on the curve.  

3.7.6 Link statistics recording 

Record data 
Activates or deactivates data recording for the link. Deactivation clears all recorded 
data. 

Record statistics 
Activates or deactivates statistics recording for the link. Deactivation clears all 
recorded statistics. 

Skip instant change stats 
Excludes zero duration observations from the statistics recording for the link. If 
applied, multiple identical states, intermitted only by instantaneous changes, form a 
single continuous observation.  
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3.8 Custom 

The Custom tab on the Object properties console displays the customization panel. 
This panel enables adaptation of certain incidents for servers and links in the 
simulation by customizations. An incident customization has a script programmed in 
a script language that tweaks the behavior of a server or link object for a specific 
incident in the simulation. This topic discusses the management of incident 
customizations. Script coding techniques are discussed in general in the 
Customization scripts topic. Procedures used specifically for incident customizations 
are discussed in the Incident procedures topic.  

3.8.1 Server customization 

The custom tab page contains the Incident table, which allows selection of a single 
simulation incident and the Customization object list, which allows selection of the 
customization object from the server or link objects selected in the viewport context.  
 

 
 
Customization scripts are composed in the Customization script  frame, which 
contains the script editor. This frame displays the customization of the server objects 
selected in the customization object list for the incident selected in the Incident table. 
The text <various> appears in the script editor if the objects selected in the object list 
have different customizations for the selected incident. In that case the Create new 
script command of the context menu of the script editor can be used to create a new 
uniform customization for all selected server objects.  
 
The remainder of this section discusses the simulation conditions that trigger the 
individual incidents and the role of the incident link and incident entity for the incident. 

Collect verify 
Invoked at the beginning of the verification routine of a collecting server. The incident 
link and incident entity are not defined for this procedure. 

Collect select  
Invoked after selection of a link with Collect method Elective in the verification routine 
of a collecting server. The selected elective link is the Incident link, which is Nil if 
selection has failed. The incident entity is not defined for this procedure. The script 
procedure iS elect  can be used to select another link. The incident does not occur 

if the server has no upstream links with the Elective Collect method. 
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Collect transfer  
Invoked at the beginning of the Transfer routine for the incident link before retrieval 
and transfer of entities. The incident entity is not defined for this procedure.  

Dispatch  
Invoked before Dispatch of an entity by a server. The dispatched entity represents 
the incident entity. The incident link is not defined for this procedure. 

Dispatch select  
Invoked after selection of a link with Dispatch method value Elective in the Dispatch 
routine of a server. The selected elective link is the Incident link, which is Nil if 
selection has failed. The dispatched entity represents the incident entity. The script 
procedure iS elect  can be used to select another link. The incident does not occur 

if the server has no downstream links with the Elective Dispatch method.  

Dispatch cast 
Invoked before casting of an entity (incident entity) to a link (incident link) in the 
Dispatch routine of a server. This customization executes first for the selection 
Elective link, if any, and then for all Escort links in top-down connection order.  

Receive 
Invoked for a non-collecting server before reception of an entity. The entity received 
is the incident entity. The link from which the entity has arrived is the incident link. 

Provide 
Invoked after selection of a server resident entity in the entity providing for retrieval or 
resource consolidation by a downstream connected collecting server. The selected 
entity is the incident entity. The link through which the entity is collected is the 
incident link. 

Discard 
Invoked before relocation of an entity by Entity discard. The discarded entity is the 
incident entity. The link to which the entity is discarded is the incident link, which is 
Nil if the server has no downstream link with Dispatch method value Discard. 

3.8.2 Link customization 

The organization of the custom tab page for link objects is equivalent to the above-
mentioned custom tab for servers. The incident link is not defined for link incidents.  
 

 
 
There are two incidents for link objects, which are both related to entity travel. 

Travel start 
Invoked before the entity starts to travel on the link. The travelling entity is the 
incident entity. 

Travel end 
Invoked before the entity ends traveling on the link. The travelling entity is the 
incident entity. 
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Provide 
Invoked after selection of a link resident entity for Transfer. The selected entity is the 
incident entity.  
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3.9 Runtime 

Operation server and link properties have a current and an initial reset-state value. 
The reset-state value is displayed on the Logic tab. The current values are presented 
on the Runtime tab, which appears only if a simulation is paused. The current value 
of all properties available on the Runtime tab are also accessible by scripting 
commands. 

3.9.1 Server runtime properties 

The set of runtime properties available in the Operating properties frame is identical 
to the property set in the Operational properties frame on the server Logic tab. The 
Server runtime tab also contains the Displayed properties frame that presents the 
current values of two additional properties, which are the server Icon property and 
the symbol Text property. Changes made to the current values are implemented into 
the simulation when resumed and cannot be undone. 

3.9.2 Link runtime properties 

The set of runtime properties available in the Operating properties frame is identical 
to the property set in the Operational properties frame on the link Logic tab. Changes 
made to the current values are implemented into the simulation when resumed and 
cannot be undone. 
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4 Simulation properties 

The Simulation properties console provides access. The object properties console is 
opened by the Simulation properties command on the Tools menu or by double-
clicking the viewport.  
 

 
 
The main tab strip at the top of window determines the category of which properties 
are displayed.  
 
This section has a topic for each item on the tab strip: 

¶ Clock 

¶ Components 

¶ Events 

¶ Errors 

¶ Results 
 



 Renque user's guide 

- 55 - 

4.1 Clock 

The Clock tab of the Simulation properties console determines the time span of the 
simulation and the properties of a user-adapted built-in clock, which controls the 
Simulation timing.  
 

 
 

4.1.1 Reference frame 

 

Time unit 
Defines the physical time unit applied to the clock. Some clock functions are 
unavailable for the default value Dimensionless. If a dimension is selected the 
Clock program frame is shown 

Calendar based 
Selects the Gregorian calendar as reference frame for the simulation clock. If 
checked, the Timetable calendar is enabled. The check box is not available if the 
Dimensionless value has been selected in the above-mentioned Time unit dropdown 
list. 
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4.1.2 Simulation extent 

 

Replications 
Sets the number of replications for a simulation run. The maximum number of 
replications is 32000.  

Start 
Specifies the clock start weekday. Not available if the Dimensionless value has been 
selected for the Time unit of the clock. The Start property requires selection of a 
weekday from the dropdown menu. 

Time limit 
Specifies the maximum run time for all simulation replications in the 
non-Calendar based clock. The run time is expressed in the selected Time unit as 
positive floating-point number. An empty text field (Default) signifies that the 
simulation is performed endlessly. 
 
For the Calendar-based clock the simulation start and end are determined by 
calendar dates. 
  

 

Start date 
Specifies the start date for the clock calendar. The property requires specification of 
a date in the date format of the operating system. The default value Today denotes 
the current date of the operating system clock. 

End date 
Specifies the end date for the clock calendar. The property requires specification of a 
date in the data format of the operating system. The value Today denotes the current 
date of the operating system clock. An empty text field (Default) signifies that the 
simulation will be performed endlessly.  

4.1.3 Animation timing 
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Timed travel 
Specifies the base display time for timed link travel in milliseconds real time per 
simulation Time unit as positive floating point number. If left empty a default value is 
used which depends on the time-related object properties in the model. 

Instantaneous travel 
Specifies the base travel display time for instantaneous link travel in milliseconds real 
time as positive floating point number.  

Speed control range extent 
Specifies the span of the of the animation speed range controlled by the 
Animation speed slider. The pulldown menu requires a selection out of five values.  

4.1.4 Clock program 

The clock time is expressed in the 12 or 24-hour clock system and weekdays are 
distinguished if a dimensional Time unit has been selected for the clock. The 
dimensional selection also presents the Clock program frame. The Calendar-based 
clock program is an agenda of user-defined timetables which are consecutively 
activated on a specified start date. A timetable defines the operational time pattern of 
each week day. The Timetable calendar control located on the left of the frame 
contains a list of clock program timetables organized by start date. The Timesheet 
control located on the right displays the configuration of the selected timetable item in 
the timetable calendar. If the clock is not Calendar-based the Default item is the only 
timetable defined and the timetable calendar control is disabled. 
 

 
 

Timetable calendar 
The timetable calendar control contains a number of timetables organized in rows. 
The start date of an item is specified in the column labeled Start by typing a date 
value in the systemôs date format. Timetables can be added and deleted by 
commands on the context menu of the agenda. The first row with start value Default 
is fixed and cannot be changed or removed. A timetable is valid if it has a start date 
later than the start date of the previous valid timetable. Invalid timetables are ignored 
in the simulation. A timetable becomes active on the start date value and remains 
active until the start date of the next valid item in the calendar. A checked box in the 
column labeled Dflt denotes that the timetable item activated on the specified date is  
default timetable of the first row. 

Timesheet  
The Timesheet control displays the properties of the selected timetable in the above-
mentioned timetable calendar. The timesheet has a row for every day of the week. 
The first column specifies the abbreviated weekday name, with a check box to 
enable/disable the corresponding day in the timetable. The other columns define the 
Start time and End time of day segments in column pairs. By default, the timesheet 
has a single column pair. Column pairs can be added using the context menu of the 
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timesheet and of an active cell. A day segment is invalid if the start time value is later 
than the end time value, or if the start time value is earlier than the end time value of 
the previous valid day segment. A week day with an invalid first day segment is 
skipped in the simulation.  If the Uniform week item of the context menu of the 
timesheet is checked, the selected timetable is uniform for all days of the week and 
the timesheet has only one row. 
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4.2 Components 

The Components tab provides access to component objects. Components are user-
creatable project elements which are not displayed on the viewport. The 
Component repository on the left side of the tab contains a categorized list of the 
component objects defined within  the project. The repository is used to create, 
delete, and select components. New components are created with the New and 
Duplicate commands of the context menu of the Component repository. 
Components are removed be the Delete command. 
 

 
 

The tab displays the properties of the components selected in the 
Component repository. The component properties are displayed in frames, which are 
only visible if all selected components are of the same type.  
 
The properties of the component types are discussed in separate topics: 

¶ Variables 

¶ Attributes 

¶ Distributions 

¶ Schedules 

4.2.1 Variables and attributes 

Variable and Attribute components are used to store data. Attributes are used to 
store data in entities. Variables are used to store data locally in server and link 
objects, as well as globally outside the scope of an object. Variable and Attribute 
values are stored and accessed by scripting. The stored value is a variant of type 
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Integer, Double, String, Boolean or Nil, or a Renque object other than a variable or 
attribute. 

4.2.2 General properties 

 

 
 

Name 
Name of the component. The name of each object is unique in the project. 

Default Value 
Default value of the component. Permitted values for the default property are integer 
and floating point numbers, strings and booleans. The format of the specified value is 
recognized automatically.  

Hide result 
Hides the component in the Variable value data sheet or the Attribute value data 
sheet. 
 

4.2.3 Component data 

 

 

Record data 
Activates or deactivates data recording for the component. Deactivation clears all 
recorded data. 

Record statistics 
Activates or deactivates statistics recording for the component. Deactivation clears all 
recorded statistics. 

Skip instant change stats 
Excludes zero duration observations from statistics recording for the component. If 
applied, multiple identical states, intermitted only by instantaneous changes, form a 
single continuous observation.  

4.2.4 Distributions 

Distribution components are objects that generate a random number when 
evaluated. Distribution components are defined by a probability density function 
(PDF), which determines the spread of the numbers generated by the component.  
 



 Renque user's guide 

- 61 - 

 
 

Type name 
The Type name property may contain a maximum of 255 characters in the ranges A-
Z, a-z, 0-9 and the underscore _ character. The property must start with an 
alphabetic character. The type name must be unique to the distribution components 
and is case-insensitive. The name of an object consists of the type name followed by 
the below-mentioned non-zero index value. The name of each object is unique in the 
project.  

Index 
The index property of an object in an integer number >0. When the index property is 
changed, indexing of the selected objects starts with the specified value, where the 
index value of non-selected objects with the same type name are skipped. 

Probability density  
Selects the probability density function for the distribution component. The available 
functions are given in the table below. In this table, the parameter x indicates the 
random value. Where not indicated otherwise, x is a real number without range limits. 
The symbol ũ represents the Gamma function. 
 

Name Parameters Probability density Restraints 

Exponential Mean l  l >= 0 , x >= 0 

Triangular 
Minimum a 
Modus m 
Maximum b 

 
a <= x <= m 

 
m < x <= b 

Uniform 
Minimum a 
Maximum b 

 
a <= x <= b 

Normal 
Mean ɛ 
Variance ů2 

 

ů > 0 

Weibull 
Shape Ŭ 
Scale ɓ  

 

Ŭ > 0, ɓ > 0  

x >= 0 
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Binomial 
Trials N 
Probability p 

 

0 <= p <= 1 

N = 0,1,2 ; x = 0,1,2..N 

Poisson Shape n 

 

ɜ >= 0  

x = 0,1,2...  

Gamma 
Shape k 
Scale ɗ 

 

k > 0, ɗ > 0, x>= 0 

Beta 
Shape a 
Shape b 

 

a > 0, b > 0 

 

Distribution parameters 
Parameter data may by entered in the text fields below the PDF combo box. The 
available parameters depend on the selected distribution function. The parameter 
value ranges allowed are listed in the right-most column of the table above.  

4.2.5 Schedules 

Schedule components execute a user-defined Customization script at specific time 
points in the simulation by a schedule event in the Event calendar. 

4.2.6 General schedule properties 

The schedule frame is shown if one or more schedule components have been 
selected in the Component repository. The schedule properties are defined by the 
Schedule grid and a number of additional controls on the frame.  
 

 

Type name 
The Type name property may contain a maximum of 255 characters in the ranges A-
Z, a-z, 0-9 and the underscore _ character. The string must start with an alphabetic 
character. The type name must be unique to the distribution components and is 
case-insensitive. The name of an object consists of the type name followed by the 
below-mentioned non-zero index value. The name of each object is unique in the 
project. 
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Index 
The index property of an object in an integer number >0. When the index property is 
changed, indexing of the selected objects starts with the specified value, where the 
index value of non-selected objects with the same type name are skipped.  

Priority 
Determines the event priority of simulation events created in the Event calendar by 
the schedule. Possible values: integer number in the range -16000 to +16000. 

Method 
Selects one of the following schedule methods: 

¶ Simulation time (Default). 
The Simulation time method uses the simulation time reference frame for 
schedule timing evaluation. The timing properties of the schedule are specified 
as simulation time values for this method. 

¶ Simulation clock  
The Simulation clock method uses the clock reference frame for the schedule 
timing mechanism. Selection of the Simulation Clock method renders the 
Recurrence pattern frame visible, provided a dimensional Time unit has been 
specified for the simulation clock. 

¶ Runtime transition 
Under application of the Runtime transition method execution of the schedule is 
triggered by changes in the operation of a simulation. This schedule method does 
not apply any schedule timing properties, and the Runtime transition frame is 
shown in place of the Timing frame. 

Autostarting 
Enables self-initialization of the schedule (Default). Makes the schedule start 
automatically when a simulation replication starts. A schedule is activated only by the 
schedule scripting procedure Run if this option is deselected. 

4.2.7 Timing  

The Timing frame appears when the Simulation time value is selected for the 
schedule Method. The frame displays a list of schedule recurrence times. A schedule 
event is created for item in the list. The list cannot be edited if multiple schedule 
components are selected.  
 

 
 
The first column displays a line number. The second column displays the schedule 
recurrence time as a floating point number >= 0. The recurrence time represents the 
simulation time offset from the start time of the schedule run. Rows can be inserted 
and deleted by commands in the context menu of the list. The timing values be 
edited by clicking the on the list.  
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Repeating 
Enables cyclic schedule execution. By default the schedule process is terminated 
when the last schedule line has been executed. If this property is applied, the 
schedule is re-run after execution of the last schedule timing.  

4.2.8 Recurrence pattern  

The Recurrence pattern frame appears when the Simulation Clock value is selected 
for the schedule Method. The frame is enabled if a dimensional Time unit has been 
specified for the simulation clock. The composition of the frame depends on the 
Calendar-based clock property. The frame presents the following three recurrence 
properties if the simulation clock is not Calendar-based. 
 

 
 

Clock time 
Determines the recurring clock time of the schedule event. 

Weekday 
Determines the day recurrence pattern of the schedule event. The default value 
<None> signifies that the recurrence pattern is controlled by the below-mentioned 
Day interval property, ignoring weekdays. The value <All> results into daily 
recurrence. 

Day interval 
Specifies the number of days between schedule event recurrences as a positive 
integer number. The default value 0 results into a single schedule event on the 
schedule start day. The value 1 results into daily recurrence. 
 
The frame presents the following additional recurrence properties for the 
Calendar-based simulation clock. 
 

 
 

Day 
Determines the recurrence pattern for days. The composition of this combo box 
depends on the selected value of the above-mentioned Weekday property. The 
control allows selection of a specific month day number in the range 1 - 31 for the 
weekday value <None>. For other values of the weekday property the control has the 
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possible values <All> (every day), 1st. to 5th.(occurrence number in the month) and 
<Last> (last occurrence in the month). The schedule event is skipped if the selected 
value for the Day property does not occur on the calendar in the month of recurrence. 

Month 
Selects the month for recurrence of the event. The value <All> results into recurrence 
of the event for every month in the year of recurrence. 

Year 
Selects the year for recurrence of the event. The value <All> results into yearly 
recurrence of the event. 

4.2.9 Runtime transition  

The Recurrence pattern frame appears if the Runtime transition method is selected 
for the schedule Method. This method will cause the schedule event to be executed 
when a simulation replication starts, ends, is paused or resumed from the paused 
state, as indicated in the frame. 
 

 
 

4.2.10 Customization 

Schedule customization scripts are composed in the Customization frame, which 
contains the script editor.  
 

 
 
This frame displays the customization of the schedule components selected in the 
Component repository. The text <various> appears in the script edit field if the 
selected schedule have different customizations. In that case the Create new script 
command of the context menu can be used to create a new uniform customization for 
all selected items. Script coding techniques are discussed in the 
Customization scripts topic. 
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4.3 Events 

The Events tab displays a list of events in the Event calendar, organized in order of 
creation.  
 

 
 

The list has 5 columns each displaying a specific property of the event: 

¶ Time Simulation time of the event. 

¶ Priority Priority value of the event. 

¶ Object Name of the event object. The event object can be a server 
object, a link object, a schedule component or <system>. The 
latter signifies the event is not associated with an object. 

¶ Type Description of the event type. 

¶ Message Provides information on the result of executed events. 
 
The events created by the selected item in the list are highlighted. The event listing 
does not display events that were executed before the utility was activated. The list is 
maintained during a simulation run if the Events tab remains selected while the 
simulation is running.  
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4.4 Errors 

The Errors tab displays the Error list. The list displays all runtime errors caused by 
execution if customization scripts in order of occurrence.  
 

 
 
The list has four columns: 

¶ Time Simulation time of the error occurrence. 

¶ Source Displays the simulation incident causing the error. For schedule 
components the row number that has caused the error is 
displayed.  

¶ Object Name of the object that caused the error.  

¶ Description Displays a description of the error number.  
 
The list is updated immediately when an error occurs in the simulation.  
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4.5 Results 

The Results tab provides access to simulation results.  The data tab contains the 
Data set frame at the top of the window and a Object type tab strip located below 
the Data set frame.    
 

 
 
The results are displayed in data sheets on the Object type tabs. The compilation of 
these data sheets can take a long time to complete if there are many rows to display. 
The process can be interrupted and canceled by holding down the Esc key while the 
mouse pointer appears as hourglass. The compilation can be restarted by a click on 
the sheet.  
 
The Data set frame contains several items that control which data set is displayed on 
the tab. These items are visible only if applicable to the simulation and result display 
set-up. 

Data type 
The Data type pulldown menu on the left side of the frame selects the type of results 
being displayed. The default value Simulation state represents the current value of 
objects properties in the simulation. The control also offers the options Recorded 
statistics, Recorded data and the Confidence intervals option if two or more 
replications have been completed. 

Replication 
Recorded statistics and data can be viewed for any replication by entering the 
desired Replication number in the corresponding text field or by using the adjacent 
up/down-button. The Replication selector is hidden if the number of simulation 
replications equals 1. If the replication selector text field is left empty the current 
replication is selected, as indicated by a blue text color. For the Confidence intervals 
option the empty replication text filed selects all replications.  A range of replications 
can be selected by entering the start and end replication number separated by a 
dash. In that case an additional column labeled Repl displays the replication number 
for each row in the statistics sheet if applicable.  

Page 
The page selection control appears if the displayed data set consists of more than 64 
columns. The desired section of the data set can be selected by entering the 
corresponding page number in the text field or by using the adjacent up/down-button. 

Confidence level 
The confidence level to be used in data review by confidence intervals is assigned by 
entering the desired value in the text field. All values greater than 0 and smaller than 
1 are accepted. with default value 0.95.  Only visible if the value Confidence intervals 
has been selected in the Data type pulldown menu. 
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Recording time  
Displays the time period for statistics recording. This control is read-only and visible 
only if the value Recorded statistics has been selected in the Data type pulldown 
menu. 

4.5.2 Simulation state results 

The default value Simulation state of the Data type selector presents current object 
properties. 

Server and link simulation state data sheet 
The header row of the state data sheet for servers and links indicates the parameters 
being displayed.  
 

 
 

Á Name Object name. 
Á Status Current status: Idle/Empty or Busy/Occupied or, for 

servers only Disabled. 
Á Continuity Duration of the current status. 
Á Resident count Number of residents in the server or link. 
Á  

Variable display options 
The display of local variables is controlled by the selected value of the pulldown 
menu in the Display options frame.  
 

 
The default value All values presents both global and local values for server and link 
objects selected in the viewport. The other two values present either local or global 
values. Variable values are displayed only for variables selected in the variable list, 
below the pulldown menu. Variable components to which the Hide result property is 
applied are not shown in the list.  

Variable value data sheet 
The header row of the variable value data sheet indicates the displayed parameters. 
The first column displays the variable name, which is followed by a dot and the 
server or link object name for local variable values. The other columns represent key 
values. 
 

 
 



 Renque user's guide 

- 70 - 

Attribute display options 
The display of entity attributes is controlled by the selected value of the 
pulldown menu in the Display options frame.  
 

 
 
The default value Residents presents attribute values of resident entities of server 
and link objects selected in the viewport. The menu item Travels presents attribute 
values of entities travelling non-instantaneously on a link selected in the viewport. 
The menu item Entity ID  presents attribute values of all entities which have been 
assigned an entity ID property. Attribute values are displayed only for attributes 
selected in the attribute list below the pulldown menu. Attribute components to 
which the Hide result property is applied are not shown in the list. 

Attribute value data sheet 
The header row of the attribute value data sheet indicates the displayed parameters. 
The first column displays the attribute name separated by a dot from a qualifier 
string. For the Entity ID display option the qualifier is the identifier property of the 
entity. For Residents and Travels display, the entity qualifier is the container name 
followed by the pound # sign and the entity position in the container object. The 
displayed position value is 0 for instantaneous travel. The header value of the other 
columns represent attribute key values. 
 

 
 

For completed replications the values Residents and Travels of the Attribute display 
pulldown menu present attribute values of entities with the same ID as the entities 
involved in the current simulation state. 

4.5.3 Recorded statistics and data results 

The Recorded statistics option in the Data type selector presents statistics recording 
in a data sheet on the Results tab. The Recorded data option presents 
recorded data.  
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Object display options 
The display of individual properties is controlled by the check boxes in the Display 
options frame  

 
 

Server and link statistics data sheet 
The statistics sheet displays recorded statistics data for objects selected in the 
viewport. The sheet contains a set of 8 statistical parameter values for each of the 
recorded properties. The parameters are indicated in the header row of the sheet. 
The property column displays the object and the property name separated by a dot. 
 

 
 

Server and link recordings data sheet 
The recordings data sheet displays recorded property values for objects selected in 
the viewport. 
 

 
 
The recorded properties are indicated in the header row of the sheet by the object 
and the property name separated by a dot. Each row presents a recording with the 
simulation time of the recording indicated in the first column labeled Time.  
 
As for the recorded statistics display for viewport object, the display of individual 
properties is controlled by the check boxes in the display options frame. 
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Variable and attribute statistics data sheet 
The statistics sheet displays recorded statistics data for components selected in the 
in the Display options frame. The statistics sheet contains a set of 8 
statistical parameter values for the recorded component values.  
 

 
 

The parameters are indicated in the header row of the sheet. The property column 
displays the component name followed by the key enclosed between parentheses. 
An entity qualifier is added to the property column notation as described in the topic 
Attribute value data sheet.  

Variable and attribute recordings data sheet 
The recordings data sheet displays recorded value data for the display options 
selected in the Display options frame. The header row displays the component name 
followed by the key enclosed in parentheses, separated by a dot from the server or 
link name for local variables or the entity identifier for attributes. Each row presents a 
recording with the simulation time of the recording indicated in the first column 
labeled Time. 
 

 

4.5.4 Confidence intervals 

The above-mentioned recorded statistics can be examined for variation between 
replications. Different replications of a simulation that employs distribution 
components yield different results, because each replication uses a different set of 
random numbers. In general, the value of a simulated parameter, averaged over all 
performed replications, approaches the ñtrueò parameter value as the number of 
replications grows. Because the actual number of replications for a simulation run is 
finite, there is always some uncertainty in analysis of simulation results with 
stochastic properties.  
 
The Confidence intervals data set option presents an estimation for the confidence 
interval of the Current, Mean and Rated statistical parameters, determined on the 
basis of the Studentôs t-distribution. The confidence interval represents a value range 
which contains, with a specified confidence level, the true parameter value.  
 
The analysis method applied requires the parameter value to be normally distributed 
in the replications population. However, there are many evidence that suggest that 
the method is quite robust with respect to deviations from the Normal distribution type 
in the parameter data.  

Confidence interval data sheet 
The organization of the confidence interval sheets is similar to the 
Recorded statistics results sheets. The interval is represented in the format 
Middle ± Range. The keyword <Incomplete> is displayed if there is an inconsistency 
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for a parameter in the recorded statistics of the replication series. Note that the 
Current parameter corresponds with the final value of the replication. 
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5 Simulation operation 

This section covers the operation of simulation models by the following topics: 
 

¶ Running simulations  

¶ Simulation data 

¶ Animation  
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5.1 Running simulations 

This topic discusses the various ways by which a simulation run can be controlled. 

Replications 
Some statistical data analysis methods in discrete event simulation use multiple 
equivalent simulations with different random numbers. In Renque such equivalent 
simulations are known as replications. Replications are individual simulation courses, 
starting from the Reset state, with a unique seed value for the 
random number generator. As a result, each replication is run with a different set of 
random numbers, and yields different results. The number of replications to be 
performed in a simulation run is set by the Replications item of the Clock properties 
console. The Confidence intervals option for the simulation results provides a method 
to inspect simulation data for multiple replications.  

Simulation run control 
The Run Menu has the following controls items to control the flow of a simulation run, 
of which the first three are also available as button in the simulation toolbar: 

¶ Reset Resets the simulation, discarding all data. 

¶ Restart Restarts a simulation run, discarding all data. 

¶ Pause Pauses or resumes the simulation run. 

¶ End replication Terminates a Paused replication. 

¶ Reset replication Resets the current replication, discarding all replication data. 
 
The state of the current replication has one of four possible values: Reset, Running, 
Paused and Stopped. A replication starts from the Reset state and has the Running 
state while in operation. A simulation replication terminates and assumes the 
Stopped state when there are no events left in the Event calendar or the 
predetermined Time limit or End date of the simulation clock are exceeded. The 
Customization script procedure SimStop  also terminates a running replication. 

 
A simulation run completes all replications successively without interruption unless 
paused. The state of the current replication may be toggled between Running and 
Paused using the above-mentioned Pause command or the SimPause  scripting 

statement. The Pause command resumes a simulation with the next replication if the 
current replication in the Stopped state. 
 
Mutations made to a project while the current replication is in the Paused state are 
applied when the simulation is resumed, generally without the requirement of a 
simulation reset, although some changes may affect the collect operation of a server 
when the simulation is resumed. 

Time display 
The progress of the simulation in time is displayed in the simulation toolbar. The 
simulation time can also be displayed in Symbol text. Clock properties are displayed 
in a format defined by the regional settings of the operating system. 
 
Time display is managed by a set of clock display codes. The time display string is 
edited by clicking on the Simulation time panel of the simulation control toolbar. Time 
display on symbol servers is specified in the Symbol text scope Text edit field of the 
Text tab on object properties console. The default empty string displays the short 
date and long time for the calendar-based clock, the 1-based day number followed by 
the long time for the unit-based clock, or the simulation time for the Dimensionless 
clock. Any combination of display codes can be used in both strings. All characters 
that do not represent a code are displayed as literal text.  
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5.2 Simulation data 

5.2.1 Object properties 

Renque can log several properties for viewport objects and variable and attribute 
components during a simulation run: 

¶ Residence  Entity storage time in the object. 

¶ Population  Number of entities stored in the object. 

¶ Busy/Occupied  Duration of the Busy/Occupied status. 

¶ Idle/Empty Duration of the Empty/Idle status. 

¶ Disabled Duration of the Disabled status. (Servers only) 

¶ Utilization  Ratio of Population and server Capacity.  

¶ Value Numeric variable value or entity attribute value. 
 
The Population, Utilization and Value properties are logged when the property 
value is about to change. The Occupied, Idle and Disabled properties are logged 
when the corresponding object status ends. The Residence property logs the 
residence time of individual entities when removed from storage in a server or a link. 

Data recording 
Data recording is optional for all viewport objects and for variable and attribute 
components. Data recording is deactivated by default. Activation of data recording 
results into logging of each change for one or more of the above-mentioned 
properties for inspection on the Results tab of the Object properties console.  
Data recording is activated for individual objects by the following methods:  

¶ The Record data item of the Object properties console for servers. 

¶ The Record data item of the Object properties console for links. 

¶ The Record data item of the Simulation properties console for components. 
Attribute data are recorded only for entities that have been assigned a  unique 
identifier string. 

Statistics recording 
Renque can also record statistics for viewport objects and variable and attribute 
component values. Statistics recording is considerably less memory consuming than 
data recording. Statistics recording is optional and deactivated by default. Statistics 
recording is activated for individual objects by the following methods:  

¶ The Record statistics item of the Object properties console for servers. 

¶ The Record statistics item of the Object properties console for links. 

¶ The Record statistics item of the Object properties console for components. 
Attribute statistics are recorded only for entities that have been assigned a  
unique identifier string. 

 
Statistics and data recording for server and link objects starts after execution of all 
Initialization calendar events. For variables and attributes recording starts 
immediately at the start of a simulation replication. Recording continues until the 
replication ends.  The StatisticsReset  scripting procedure discards all recorded 

observations and recommences the statistics recording process.  
 
Multiple successive server resident removal or storage operations caused by script 
procedures such as the Vacate  command, are accounted as a single observation 

for statistics and data recording. 

Statistical parameters 
A recorded property value is referred to as an observation. The following statistical 
parameters are calculated for the recorded observations: 
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¶ Current  Current property value pending recording as observation. 

¶ Count Number of observations: N.  

¶ Sum Sum of the observations S X. 

¶ Mean Algebraic mean of the observations: m = S X / N. 

¶ Variance Variance of the observations: S (X - m)2 / N. 

¶ Minimum Minimum value of the observations 

¶ Maximum Maximum value of the observations. 

¶ Rated Property-dependent fractional parameter. 
 
The significance of the Rated property varies between the recorded properties: 

¶ Holdup Ratio of the mean Residence and the recording time 

¶ Time-averaged Time-averaged value: S (XÖdt) / S dt, where dt is duration of 

observation X for the Population and Utilization object 
properties and the Value property of variable and attribute 
components: 

¶ Fraction Fraction of the total status time S X with respect to the 
recording time for the Busy/Occupied, Idle/empty and 
Disabled properties. 

 
The parameter Current signifies the pending observation, i.e. the value to be 
recorded if observation recording were imminent. The Current parameter of the 
Residence property presents the mean residence time of all entities presently stored 
in the server or link. The current Residence is Nil if the object has no residents. The 
current Utilization is defined as 0 for the server Capacity Nil and as Nil for server 
Capacity 0. The current value of the Occupied, Idle and Disabled properties is Nil if 
the property doesnôt represent the current object status. The value Nil as well as non-
numerical variable and attribute values are not recorded as data or as statistics 
observation.  
 
The Current value of the Population property may differ from the value returned by 
the ResidentCount  function if the Skip instant change stats is applied. The same 

goes for the Value parameter of component statistics if the Skip instant changes 
option is applied to a variable or attribute component.  

5.2.2 Data storing 

Variable and attribute components are used to store simulation data. These 
component types can contain all data types of the XojoScript language, except for 
user defined script classes and variable and attribute objects. If an entity or other 
object reference stored in a variable and attribute component is destructed or deleted 
in the model it is also removed from the component.  

5.2.3 Data review 

Recorded Simulation data and statistics can be examined on the Results tab of the 
Object properties console. This feature provides access to all available data for 
server and link objects, as well as variable and entity attribute values. The recorded 
statistics are also accessible by scripting through statistics procedures.   
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5.3 Animation 

Animation in Renque has a dual purpose. Animation can be employed as visual 
debugging instrument and as presentation support. As demonstrated in the figure, 
the following server and link elements are displayed in animation: 

¶ Server icon 

¶ Server caption 

¶ Server residents 

¶ Server residents count 

¶ Server residents curve 

¶ Link curve 

¶ Link residents 

¶ Link travel  
 

 
The animation display characteristics of individual server objects are controlled by 
the Server animation options of the object properties console, and for links by the 
Link animation options. In addition, the display style of server can be modified on the 
Display tab of the object properties console.  

Entity travel 
Link travel is animated by motion of entity icons along the link curve. The speed of 
motion is determined by the Travel time assigned to the entity. Instantaneous travel 
on links is animated using a uniform apparent travel speed, determined by the 
instantaneous travel animation timing property. The simulation time does not 
advance during instantaneous travel animation and all other travelling are entities 
static. The animation speed of entity travel on links is controlled by the 
Animation speed slider item on the Menu bar. 

Resident entities 
Entities stored in a server or in a link are painted as a queue on the residents curve 
or link curve. The number of entities displayed is limited by the length of the curve.  

Animation display order 
Servers are painted in the viewport in back-to-front z-order, such that server display 
elements with higher z-order level can partly or completely cover the display 
elements of servers with lower z-order level. Newly created servers are placed on top 
of existing servers. The z-order level of existing servers can be modified by the order 
menu of the Format Menu. Resident curves and link curves are displayed on top of 
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the highest server z-order level. Link curves are painted on top of the resident 
curves. The paint order of link curves cannot be changed. 
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6 Customization scripts 

Customization of a simulation for link and server incidents and for schedule 
components is performed by scripts. A customization script is a small program written 
in the XojoScript language. This language is a dialect of the traditional programming 
language BASIC, which is one of the easiest language to read and write. Scripts can 
accomplish particularities in the behavior of a simulation at a level of detail that 
cannot be reached by adjustment of the standard object properties.  
 
One does not require extensive knowledge of the scripting language nor does one 
need to be familiar with programming techniques to use scripts in a Renque project. 
The following script examples illustrate the type of syntax typically used. 
 
Active. Retention  = 6.2  

sets the Retention property of a server named Active equal to 6.2 
 
Variable 1 = Variable 1 + 1  

increments the global value of the variable named Variable1 
 
if Variable 1 = 2  then Active.Capacity  = 5  

sets the Capacity property of server Active to the value 5 only if the value of 
Variable1 equals 2. 
 
This section focuses on the use of Xojo scripts in the Renque simulation 
environment. General information on the XojoScript language can be obtained 
through the web link: http://docs.xojo.com/index.php/Scripting_Language.  
 
Some notes for the reader who is familiar with other Basic script dialects: 

¶ The For...Next loop construction in the XojoScript language re-evaluates the final 
value of the counter in every loop iteration.  

¶ Late-binding of variables is not supported 

¶ Automatic type casting from the floating point to the integer variable type results 
into round-off to the nearest whole number towards zero.  

 
The Renque scripting syntax topic provides general information about Renque 
scripting. All available Renque procedures are discussed, categorized by object 
context, in the topics: 

¶ Global procedures 

¶ Incident procedures 

¶ Entity procedures 

¶ Server procedures 

¶ Link procedures 

¶ Component procedures 

¶ Clock procedures 

¶ Statistics procedures 
The notation used in these topics specifies the procedure name, followed by the 
procedure arguments enclosed in parenthesis. The procedure type (Statement, 
Function or Property) is given, together with the return value type for functions and 
properties.  
 
A complete list of the available Renque procedures in alphabetical order is given in 
the Reference section.  
 

http://docs.xojo.com/index.php/Scripting_Language
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6.1 Renque scripting syntax 

6.1.1 Object references 

Scripts can be used to assign and read object properties and to impose certain 
transformations on objects in the simulation project.  

Direct object references 
All server, links and components can be accessed in scripts by their Name property. 
A direct reference by name is preserved in the script if the name property of the 
object is changed in the sense that the name also changes in the script. Viewport 
objects and all components except for variables and attributes can also be accessed 
by the Type name followed by the Index enclosed in parenthesis as in an array 
construction. For example, the server or component named Element1 may be 
referenced as Element(1) . Note that the index argument 1 in this expression is not 

restricted to integer numbers. Any expression that evaluates to a number may be 
used on the index placeholder. The typename referencing method is non-preserving, 
which means that the Element(1)  reference is lost when the Type name or Index of 

the Element1 object is changed.  

Indirect object references 
Some global and object procedures return a reference to a viewport object, a 
component or an entity. The server script procedure Links , for example, returns a 

link object connected to the server. Links have similar procedures that return a 
connected server object. Entity objects can only be referenced indirectly. The shared 
server and link procedure Residents , for example, returns a resident entity of the 

object.  

Variable and attribute references 
Variable and attribute objects, which are used to store data, are referenced by the 
name of the Variable or Attribute component. A directly referenced variable or 
attribute object such as in the code line: 
Variable 1 = Variable2  

automatically references the value stored in the object rather than the object itself. 
The statement results into assignment of the value of one variable object to the 
value of the other. A variable or attribute object returns the default value of the 
component until a value has been assigned. 
 
Values can be stored in a variable or an attribute with an integer value or a series of 
integer values as key. The code line 
Variable 2( 1,2,2 ) = "A"  

stores the string value "A" in the variable named Variable2 with key combination 
(1,2,2). An unlimited number of integer keys can be passed, separated by commas. 
Note that it is not necessary to dimension variable and attribute objects for keys, as 
opposed to array variables defined in a customization script, such as for example in:  
Dim X(3) as I nteger . 

which declares a script variable within a customization script.  
 
Local variables are accessed by a server or link object reference followed by the 
variable name, separated by a dot: For example: 
Active.Variable 2( 4)  = 3  

assigns the value 3 to the variable named Variable2 of the server named Active with 
key value 4. 
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Attribute values can only be accessed as entity property by an entity reference 
followed by the attribute name, separated by a dot: For example: 
Object1 .Residents(1).Attribute 2( 4)  = 3  

assigns the value 3 to the Attribute named Attribute2 of the first resident of the server 
or link object named Object1, with key value 4. 
 
An indirectly accessed variable or attribute component references the component 
object itself and not the value stored in the component: 
Active.Retention  

references a variable or attribute object, if assigned to the server Retention property, 
and not it's value. 

Type casting 
The XojoScript language requires a method called casting to access a property of 
which the type is undetermined. Casting involves an operator statement that explicitly 
expresses the object type. For example: 
Entity(Variable 1). Identifier  

returns the Identifier property of an entity that is stored in variable component 
Variable1. Omission of the Entity()  in the previous syntax would cause a 

compilation error because the return value type of a variable component is a variant 
and not an entity. Execution of the above syntax causes a runtime error if Variable1 
does not contain an entity. The IsA operator can be used to verify an object type.  
 
The cast operator Object()  must be used to obtain a reference to a directly 

accessed variable or attribute component, as opposed to the value stored in the 
component. For example: 
1.  Link 1.Travel = Object(Variable1)  

2.  Link 1.Travel  = Variable1  

If Variable1 is a variable object then line 1 assigns the variable object Variable1 to 
the Travel property of the link named Link1, whereas line 2 assigns the value of 
Variable1. 

Special script object references 
The link and server object of an incident customization and the schedule component 
of a schedule customization are named customization object. This script object is 
returned by the function iSelf .  It may be referenced implicitly by omission of the 

object name. For example, the two scripts 
Active. Retention  = 6.2   and  . Retention  = 6.2  

are equivalent for an incident customization of server Active. Similarly: 
Schedule 1. Termin ate    and  . Termin ate  

are equivalent for the schedule customization of schedule Schedule1. The implicit 
customization object reference notation is recognized only if preceded by a symbolic 
operator, a space, a comma, a line feed, or an opening parenthesis. 
 
Some incident customizations involve a specific entity, such as the entity received for 
the Receive incident. This entity, which is named incident entity, is returned by the 
function iEntity . It may be referenced implicitly by omission of the iEntity  

procedure altogether. For example: 
iEntity . Icon  = BlueBall  and Icon = BlueBall  

are equivalent. 
 
Some server incident customizations involve a specific link, such as the link to which 
the incident entity is dispatched in the Dispatch cast incident. This link, which is 

http://docs.xojo.com/index.php/IsA
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named incident link, is returned by the function iLink . The incident link cannot be 

referenced implicitly. 

Keywords 
The following keywords have a particular significance in Renque scripting: 
Nil  Can be assigned to some object properties to render the property 

inactive.  
True, False  Are used to represent Boolean object property values. 

Renque scripting procedures 
Besides the standard elements of the XojoScript language, Renque offers an 
assortment of scripting procedures that provide access to the properties of a 
simulation project and its elements. The procedure names match the property names 
displayed in the user interface for object properties, such as the Retention and Icon 
properties. 
 
In accordance with the syntax rules of the XojoScript language, the general form of a 
Renque script procedure is given by: 
ProcedureName[(argument1,[argument2,[...]])]  

 
A procedure may or may not require one or more arguments, separated by commas. 
The square brackets in this definition indicate optional arguments. A default value is 
used if an optional argument is omitted in a procedure call. The default value is 0 for 
the integer and floating point arguments, False for a boolean and Nil for an object. 
 
The Xojo language has three procedure types.  
1. The Statement procedure type, which does not have a return value 
2. The Function procedure type, which does have a return value 
3. The Property procedure type, which can be used to both assign and evaluate 

property values.  
 
The code structure of three procedure types is as follows:  
StatementName[(é)] 

é = FunctionName[(é)]  

PropertyName[(é)] = é   and    é = PropertyName[(é)] 

 
Renque scripting procedures generally have a specific object type context, which is 
determined by the object type to which the procedure is applicable. The Capacity  

procedure, for instance, is defined only for servers. Some procedures have a global 
context, which means that they are not applied to an object, and some procedures 
have a shared object context which means that they are defined for two or more 
object types.  

6.1.2 Runtime errors 

A script that contains a syntax error is said to be invalid. Invalid scripts are not 
executed in a simulation run. Valid scripts can still cause errors in a simulation run for 
a variety of reasons. Such errors are known as Runtime errors. Runtime errors do 
not cause a simulation run to be stopped. If a runtime error occurs, the execution of 
the script causing the error is aborted, but the simulation will continue as normal. 

Error messages 
All runtime errors create an entry in the Errors list, for review by the project designer. 
The list may contain general XojoScript error messages and Renque-specific error 
messages. The Script error codes presents a complete list of Renque error 
messages. 
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6.2 Global procedures 

Global procedures are called without reference to an object. The available global 
procedures are: 

Object-referencing procedures 

iSelf  

Function (Object). Returns the server or link object of an incident customization or 
the schedule object of a schedule customization. 

Clock  

Function(Object). References the simulation clock. Required to call clock procedures. 

Miscellaneous procedures 

SimTime  

Function(Floating point). Returns the simulation time as a floating-point number. 

SimPause  

Statement. Pauses the simulation after execution of the current calendar event.  

SimStop  

Statement. Forces termination of the current replication.  

Statistics(GlobalVar as Variable)  

Function(Object) . Returns the statistical data object for the global values of the 
Variable passed as object to the argument GlobalVar, which is used to access 
Statistical parameter functions for variable components. 
Example:  
The syntax Statistics(Var(1)).Mean  returns the mean of all values assigned to 

Variable Var with index 1. 

StatisticsReset  

Statement. Clears all recorded statistics data for the current simulation replication 
and reinitializes recording.  

AnimationFreeze[Timing as Double = 1 , Realtime as Boolean]  

Freezes the animation for a time period determined by the argument Timing. If the 
value True is passed for the optional argument Realtime the Timing argument 
represents the time period in milliseconds real time. Otherwise the Timing argument 
represents the proportionality factor between the applied time period and the 
instantaneous travel animation time.  
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6.3 Incident procedures 

Incident procedures have special functions for specific incident customizations. They 
are global procedures of which the name starts with the letter i that can only be called 
for particular incidents. The available incident procedures for the different simulation 
incidents are given in the following table.  
 

Incident Object iSuspend   iCancel  iTiming  iSelect  iExclude  iRandomBias  

Server incidents        

Collect verify  ǒ    ǒ ǒ 

Collect select L    ǒ   

Collect transfer L ǒ ǒ     

Dispatch E  ǒ   ǒ ǒ 

Dispatch select  L/E     ǒ   

Dispatch cast L/E   ǒ     

Receive L/E    ǒ    

Provide L/E  ǒ   ǒ   

Discard L/ E  ǒ     

Link incidents        

Travel start E   ǒ    

Travel end E       

Provide E  ǒ ǒ ǒ   

  
The first column indicates whether or not the incident link (L) and incident entity (E) 
are defined for an incident. The other columns mark whether or not the incident 
procedures given in the column header are available for an incident. This topic 
discusses the purpose of each of these procedures for the individual incidents for 
which they can be used.  
 
The customization object is obtained from the iSelf  procedure, which is available 

for all incident types. 

6.3.1 Server incident procedures 

iEntity  

Function(Entity). Returns the incident entity of the simulation incident.  

iLink  

Function(Link). Returns the incident link of the simulation incident. The return value 
can be Nil for the Collect select, Dispatch select and Discard incidents. 

iSuspend  

Statement. Postpones an action of the collect operation of the server. Overruled by 
the below-mentioned iCancel  statement. 

¶ Collect verify incident 
Halts the verification routine of the collect operation. The halted verification 
routine is resumed by any of the actions that could cause incitation of the 
server.  
Example:  
If .ResidentCount > = .Capacity  then iSuspend   

postpones the restart of a collection procedure until the server has space to 
store another entity.   
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¶ Collect transfer incident 
Halts transfer of entities by the server through the incident link. The halted 
transfer is resumed by any of the actions that could cause incitation of the 
server.  
Example:  
If .CollectCount(Count.Unavailable) <> 0 then iSuspend   

postpones transfer of entities to the server until all collected entities are 
available for collection.  

¶ Provide incident 
Suspends retrieval of the incident entity by the destination server of the 
incident link. The incident entity is reserved for collection through the incident 
link and can no longer be retrieved through another link. The statement is 
ignored if all entities collected through the incident link are available for 
collection, which is always the case for resource consolidation. The statement 
does not suspend the transfer routine of the server.  
Example.  
The unconditional iSuspend  call in the server provide incident postpones 

entity retrieval until all entities collected through the incident link are available.  

iCancel  

Statement. Cancels a server action. The statement does not end execution of the 
customization script as the XojoScript Return  statement does.  

¶ Collect transfer incident 
Cancels the transfer and collection of entities through the incident link.   

¶ Dispatch incident 
Cancels the dispatch action of the incident entity from a server. The incident 
entity remains stored in the server. 

¶ Dispatch cast incident 
Cancels casting of the incident entity and destructs the entity. 

¶ Discard incident 
Cancels the discard action of the incident entity from a server. Cancelation of 
the discard action caused by capacity reduction results into a server resident 
count greater than the server capacity property. For cancelation by other 
causes the entity remains stored in the server with retention value Nil. 

iTiming  

¶ Receive incident 
Property(Variant). Returns or reassigns the evaluated retention time for 
storage of the incident entity in the server upon entity reception. The value Nil 
signifies that the retention property is not applied. Assignment of a numeric 
value requires a number >= 0.  

iRandomBias ( Index  as Integer )   

Property(Double). Assigns probability weight factors to an elective link for random 
selection. Permitted values for the iRandomBias assignment are floating-point 
numbers >= 0.   

¶ Collect verify incident 
Assigns a probability weight factor to an upstream link of Collect method 
Elective for selection by the server Collect method Random. The argument 
Index denotes the 1-based link position in top-down order of connection to 
the destination server. The procedure is only effective is the server has 
multiple selectable elective upstream links. Links subjected to the random 
selection method that have not been addressed by the iRandomBias 
assignment assume the value 1 for the weight factor. 



 Renque user's guide 

- 87 - 

¶ Dispatch entity incident 
Assigns a probability weight factor to a downstream link of Dispatch method 
Elective for selection by the server Dispatch method Random. The argument 
Index denotes the 1-based link position in top-down order of connection to 
the origin server. The procedure is only effective is the server has multiple 
selectable elective downstream links. Links subjected to the random selection 
method that have not been addressed by the iRandomBias assignment 
assume the value 1 for the weight factor. 

iExclude (Index as Integer)  

Statement. Excludes elective links from selection  

¶ Collect verify incident 
Excludes an upstream link of Collect method Elective from selection by the 
verification routine of a collecting server for selection. The argument Index 
denotes the 1-based link position in top-down order of connection to the 
destination server. 

¶ Dispatch incident 
Excludes a downstream link of Dispatch method Elective for selection in the 
dispatch routine of a dispatching server. The argument Index denotes the 1-
based link position in top-down order of connection to the origin server. 

iSelect ( Index as Integer)  

Statement. Assigns the selected elective link or the selected resident entity. The 
preselected elective link is the incident link and the preselected entity is the incident 
entity. 

¶ Collect select incident 
Changes the selected Elective link for the collect operation of the server. The 
argument Index denotes the 1-based link position in top-down order of 
connection to the destination server. 

¶ Dispatch select incident 
Changes the selected Elective link for the Dispatch routine of the server. The 
argument Index denotes the 1-based link position in top-down order of 
connection to the origin server. 

¶ Provide incident 
Statement. Changes the resident entity selected by the server for retrieval. 
The argument Index of the statement denotes the resident position of the 
entity as in the server Residents  function.  

6.3.2 Link incident procedures 

iEntity  

Function(Entity). Returns the incident entity associated with the simulation incident.  

iCancel  

¶ Provide incident 
Statement. Cancels the transfer of the incident entity and destructs the entity, 
which results into one less entity collected.  The statement does not end 
execution of the customization script as the XojoScript Return  statement 

does. 

iTiming  

Property(Variant). Accesses the timing property for entities. Assignment of a numeric 
value requires a number >= 0. 

¶ Travel start incident 
Returns or reassigns the evaluated travel time for the incident entity on the 
link. The value Nil signifies instantaneous travel.  
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¶ Provide incident 
Returns or reassigns the evaluated retention time for storage of the incident 
entity in the collecting server. The value Nil signifies that the retention 
property is not applied.  

iSelect( Index as Integer)  

Statement. Assigns the selected resident entity.  

¶ Provide incident 
Changes the selected resident entity of the incident link for transfer to the 
server. The argument Index of the statement denotes the resident position of 
the entity as in the link Residents  function. The preselected entity is the 

incident entity. 
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6.4 Entity procedures 

Entity procedures are used to obtain information on the status of an entity or to cause 
the entity to undergo some transformation. The following Entity procedures are 
defined: 

Property-referencing procedures 

Icon  

Property(Picture). Returns or sets the Icon  property of the entity as picture object. 
The value Nil represents the default entity icon. 

Identifier  

Property(String). Returns or assigns an identifier string of an entity. The property 
assignment accepts any non-empty string value. The assignment raises an error if 
the assigned string is used as identifier by another entity or if the entity already has 
been assigned an identifier string.  

Continuity  

Function(Floating point). Returns the simulation time of the last transaction of the 
entity by which the entity was created, stored as resident in a server or link, or started 
travel on a link. 

EventTime ( [Prio as Integer] )   

Property(variant).  Returns or reassigns the simulation time of the calendar event that 
controls dispatch, discard by expiration or timed travel of the entity. Assignment of 
the property replaces the event with a new event. The property returns Nil if the entity 
does not have one of these three event types associated with it. A dispatch or 
expiration event is removed if the value Nil is assigned, resulting into entity storage in 
a server without release event. The optional argument Prio can only be used for the 
property assignment and determines the priority of the new event. The property 
assignment raises a runtime error if called on the incident entity. The server incident 
procedure iTiming  or the link incident procedure iTiming  must be used instead of 

the EventTime property to control the transaction timing of the incident entity. 

Host  

Function(Server|Link). Returns the server storage or resource host or the link storage 
or travel host of the entity. The function returns Nil if the entity is not stored in a 
server (as resident or resource) and not stored in or travelling on a link. The below-
mentioned functions HostIndexResident  and HostIndexTravel  can be used to 

determine the location of the entity in the host. 

Host Index Resident  

Function(Integer). Returns the Residents  position of the entity. The function returns 

the value -1 if the entity is stored as resource in a server. The function returns the 
value 0 if the entity is not a server or link resident.  

HostIndex Travel  

Function(Integer). Returns the Travels  position of the entity. The function returns 

the value -1 if the entity travel is instantaneous and the value 0 if the entity is not 
travelling. 

Other procedures  

Extract( [ Recipient  as Link ] ,  [Prio as Int eger] )  

Statement. Creates a calendar event at the current simulation time that moves the 
entity to the link object specified by the Recipient argument for link travel. The entity 
is destructed if the Recipient argument is Nil. The optional argument Prio determines 
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the priority of the calendar event. The entity is removed from its container if stored in 
server (as resident or resource) or a link, and travel is aborted if the entity is travelling 
on a link. The Entity procedures HostIndexResident  and HostIndexTravel  can 

be used to determine the location of an entity. The statement raises a runtime error if 
called on the incident entity. 

Statistics( At tri b as Attribute)  

Function(Object) . Returns the statistical data object for the entity as object, which is 
used to access Statistical parameter functions for the attribute passed to the Attrib 
argument. Not available for the implicitly referenced incident entity. 
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6.5 Server procedures 

Server procedures are called on a server object. They are used to obtain information 
on the status of the referenced server or to cause the server to undergo some 
transformation. The following server procedures are defined: 

Property-referencing procedures 

TypeName 

Function(String). Returns the Type name property. 

Index  

Function(Integer). Returns the index property. 

Name 

Function(String). Returns the name of the object, which is the above-mentioned Type 
name followed by the non-zero above-mentioned Index value.  

Icon  

Property(Object). Returns or sets the Icon property of the server as picture object. 
The default icon of the server is referenced by Nil. 

Retention ; Capacity; Priority  ([ InitValue  as Boolean ])  

Property(Variant). Returns or assigns the namesake server property. Permitted value 
ranges for assignment of the properties are given for the individual property 
descriptions. The property returns the initial value of the reset state if the value True 
is passed for the optional argument InitValue. The InitValue option cannot be used 
for property assignments.  

Disabled ; Continuous ([InitValue  as Boolean ])  

Property(Boolean). Returns or sets the namesake server property value. The 
property returns the reset state value if True is passed for the optional argument 
InitValue. The InitValue option cannot be used for property assignments. Not 
available for block servers.  

Method(Value As MethodServer , [InitValue as Boolean])  

Function(Boolean). Returns true if the value of the method property matches the 
MethodServer enumerator argument Value. The function result matches the initial 
value of the reset state if the value True is passed for the optional argument 
InitValue. The composition of the MethodServer enumerator is given in the 
Enumerators section. 
Example:  
Server. Method( MethodServer .CollectRandom)  

returns true if the current value of the server Collect method property is Random 

Method(Value As MethodServer , [InitValue as Boolean])  

Property. Assigns the value corresponding to the MethodServer enumerator 
argument Value to a server method property. The composition of the MethodServer 
enumerator is given in the Enumerators section. 
Example:  
Server. Method  = MethodServer .Dispa tchRandom  

assigns the value Random to the current value of the server Dispatch method 
property. 
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Other procedures 

Links( Index as Integer , [ ElectiveOnly  as  Boolean ] )  

Function(Object). Returns a link object connected to the server. The argument Index 
denotes the link position in top-down order of connection. A negative Index value 
references upstream links of the server and a positive value references downstream 
links. The function involves only links of Collect method or Dispatch method Elective 
if the value True is passed for the optional argument ElectiveOnly. The link 
procedures Origin Index  and  Destination Index  can be used to obtain the 

position of a specific link in the connection order.  

LinkCount Upstream ([ ElectiveOnly  as Boolean ])  

Function(Integer). Returns the number of upstream links connected to the server. 
The function returns the number of links of Collect method Elective if the value True 
is passed for the optional argument ElectiveOnly.  

LinkCountD ownstream ([ ElectiveOnly  = False])  

Function(Integer). Returns the number of downstream links connected to the server. 
The function returns the number of links of Dispatch method Elective if the value True 
is passed for the optional argument ElectiveOnly.  

Residen ts (Index as Integer)  

Function(Entity). Returns a resident entity of the server. The resident entities are 
positioned in the server by order of arrival. The argument Index denotes the 1-based 
entity position. The function returns Nil if the value passed for the Index argument 
does not match the position of an entity. The entity procedure Host Inde xResident  

can be used to determine the position of a specific entity in the server. 

ResidentCount  

Function(Integer). Returns the number of entities stored as resident in the object. 

ResidentSwap (Pos1  as Integer , Pos2  as Integer )  

Statement. Switches the positions of two resident entities stored in the server, as 
specified by the arguments Pos1 and Pos2. The arguments are positive numbers 
representing the storage position as for the Index argument of the above-mentioned  
Residents function. A runtime error is raised if the value passed for the Pos1 or Pos2 
argument does not match the position of an entity.  

Text ( [InitValue  as boolean ] )  

Property (String). Returns or assigns the Symbol text property of a symbol server.  
The property returns the initial value of the reset state if the value True is passed for 
the optional argument InitValue. The InitValue option cannot be used for property 
assignment. The procedure call causes a runtime error if the server is not a symbol. 
Assignment of the value of a numerical variable type to the text property requires 
type casting by the Str() or Format() XojoScript functions. 

CollectAbort ( [Prio as Integer] )  

Statement. Creates a calendar event for abortion of the collect operation of a server. 
The optional argument Prio determines the priority of the calendar event. The 
statement is ineffective if the server is not collecting. 

CollectCount ( Optional Parameter as Count )  

Function(Integer). Returns the sum of the link CollectCount  values of all upstream 

links of the server. The function returns the value -1 for if any of the CollectCount 
values if the server has the value -1.  

http://docs.xojo.com/index.php/Str
http://docs.xojo.com/index.php/Format
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CollectTransfer([Prio as Integer])  

Statement. Creates a calendar event which resumes a Transfer routine that was 
halted. The optional argument Prio determines the priority of the calendar event. The 
statement is ineffective if the server does not have a halted transfer routine. 

Vacate([Prio as Integer])  

Statement. Creates a calendar event that discards all residents from the server. The 
optional argument Prio determines the priority of the calendar event.  

Statistics([LocalVariable as Variable])  

Function(Object) . Returns the statistics object of the server, which is used to access 
the statistical data object for different server properties in order to obtain statistical 
data for the serve. If a variable object is passed for the LocalVariable argument the 
function returns the statistical data object of a local variable of the server, which is 
used to access Statistical parameter functions for variable components. 

Status  

Function(Integer). Returns 0 if the current server status is Idle/Empty. Returns 1 if the 
current server status is Busy/ Occupied.  Returns -1 if the current server status is 
Disabled.  

Continuity  

Function(Floating point). Returns the duration of the current server status.  
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6.6 Link procedures 

Link procedures are called on a link object. They are used to obtain information on 
the status of the link object or to cause the link to undergo some transformation. The 
following link procedures are defined: 

Property-referencing procedures 

TypeName 

Function(String). Returns the Type name property. 

Index  

Function(Integer). Returns the index property. 

Name 

Function(String). Returns the name of the object, which is the above-mentioned Type 
name followed by the non-zero above-mentioned Index value.  

Batch; Travel  ([InitValue  as Boolean ])  

Property(Variant). Returns or assigns the namesake link property Permitted value 
ranges for assignment of the properties are given for the individual property 
descriptions. The property returns the initial value of the reset state if the value True 
is passed for the optional argument InitValue. The InitValue option cannot be used 
for property assignments.  

Initializing; Completing  ([InitValue  as Boolean ])  

Property(Boolean). Returns or assigns the namesake link property. The Initializing 
assignment is only effective in a Runtime transition Schedule of type 
Replication start.  

Method(Value As Method Link, [InitValue as Boolean])  

Function(Boolean). Returns true if the value of the method property of the link 
matches the MethodLink enumerator argument Value. The function result matches 
the initial value of the reset state if the value True is passed for the optional argument 
InitValue. The composition of the MethodLink enumerator is given in the 
Enumerators section. 
Example:  
Link . Method( Method Link.Collect Mandatory )  

returns true if the current value of the link Collect method property is Mandatory. 

Method(Value As Method Link , [InitValue as Boolean])  

Property. Assigns the value corresponding to the MethodLink enumerator argument 
Value to a server method property. The composition of the MethodLink enumerator is 
given in the Enumerators section. 
Example:  
Server. Method  = Method Link .Dispatch Escort  

assigns the value Escort to the current value of the link Dispatch method property 

Connection-related procedures 

Origin  

Function(Server). Returns the origin server object of the link. For upstream open links 
the function returns Void. 

Destination  

Function(Server). Returns the destination server object of the link. For downstream 
open links the function returns Void. 
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OriginI ndex ([ ElectiveOnly  as Boolean ])  

Function(Integer). Returns the link connection position to the origin server. The 
ElectiveOnly argument has the same function as for the server procedure Links . 

The function returns the value 0 if the link has no origin server. 

Destination Index( [ ElectiveOnly  as Boolean ] )  

Function(Integer). Returns the link connection position to the destination server. The 
ElectiveOnly argument has the same function as for the server procedure Links .  

The function returns the value 0 if the link has no destination server. 

Other procedures 

Residents (Index as integer)  

Function(Entity). Returns a resident entity of the link. The resident entities are 
positioned in the object by order of arrival. The argument Index denotes the 1-based 
entity position. The function returns Nil if the value passed for the Index argument 
does not match the position of an entity. The entity procedure Host Inde xResident  

may be used to determine the position of a resident entity in a link. 

ResidentCount  

Function(Integer). Returns the number of entities stored as resident in the object. 

Resident Swap(Pos1  as in teger , Pos2  as integer )  

Statement. Switches the positions of two resident entities of the  link, as specified by 
the arguments Pos1 and Pos2. The arguments are positive numbers representing 
the storage position as for the Index argument of the above-mentioned  Residents 
function. A runtime error is raised if the value passed for the Pos1 or Pos2 argument 
does not match the position of an entity.  

Travels (Index as integer)  

Function(Entity). Returns an entity travelling on the link by timed travel. The travelling 
entities are positioned in order of travel start. The argument Index denotes the 1-
based entity position. The function returns Nil if the value passed for the Index 
argument does not match the position of an entity. The entity procedure 
Host Inde xTravel  may be used to determine the position of a specific entity in 

travels array.  

TravelCount  

Function(Integer). Returns the number of entities stored as resident in the object. 

CreateEntity([Prio as Integer] )  

Statement. Creates a calendar event for creation of an entity on the link for travel. 
The optional argument Prio determines the priority of the calendar event.  

CollectRetrieve ([Prio as Integer])  

Statement. Creates a calendar event that completes entity retrieval by the destination 
server of the link. The optional argument Prio determines the priority of the calendar 
event. 

CollectReturnResource s([Prio as Integer])  

Statement. Creates a calendar event that removes all resource entities collected 
through the link to the origin server of the link. The optional argument Prio 
determines the priority of the calendar event. The statement is ineffective if the 
destination server holds no resource entities collected through the link. 

Statistics ([LocalVariable as Variable])  

Function(Object) . Returns the statistics object of the link, which is used to obtain the 
statistical data object for different link properties. If a variable object is passed for the 
LocalVariable argument the function returns the statistical data object of the local 
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variable of the link, which is used to access Statistical parameter functions for 
variable components 

Status  

Function(Integer). Returns 0 if the current link status is Empty. Returns 1 if the link 
status is Occupied.   

Continuity  

Function (Floating point). Returns the duration of the current link status in the 
simulation time frame.  

CollectCount ( Optional Parameter as Count )  

Returns an entity count for the collect operation of the destination server of the link, 
as specified by the optional Parameter argument. The argument Parameter is the 
Count enumerator given by: 
Count.Current  (default). Number currently remaining to be transferred.  

Count. Completed  Number of completed transfers.  

Count. Available   Number currently available for collection. Returns -1 if 

the link is Completing. 
Count.Unavailable   Number currently not available for collection.  

Count.Suspended   Number of suspended retrievals. 

 
The function returns value 0 for parameter values other than Count.Available and 
Count.Unavailable if the link is not a transfer link. 
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6.7 Component procedures 

Component procedures are called on a component object. They are used to obtain 
information on the status of the object or to cause the component to undergo some 
transformation. The following component procedures are defined: 

Distribution procedures 

TypeName 

Function(String). Returns the Type name property. 

Index  

Function(Integer). Returns the index property. 

Name 

Function(String). Returns the name of the object, which is the above-mentioned 
Typename followed by the non-zero above-mentioned Index value.  

Evaluate  

Function(Variant). Returns a random number generated by the distribution 
component.  

Parameter (Index  As Integer )  

Property(Number). Returns or assigns the distribution component parameter 
specified by the argument Index. The Index argument is an integer number that 
represents the sequence number of the parameter, in the order given in the column 
labeled Parameters of the probability density list, starting with the value 1. The 
permitted parameter value ranges of the available distribution functions are also 
indicated in the list.  

Schedule procedures 

TypeName 

Function(String). Returns the Type name property. 

Index  

Function(Integer). Returns the index property. 

Name 

Function(String). Returns the name of the object, which is the above-mentioned 
Typename followed by the non-zero above-mentioned Index value.  

Run([RunID As String])  as string   

Function(String). Activates a  schedule component. The RunID argument is used 
only for the schedule Method Simulation time, which can have multiple instances. 
The argument must be omitted for the schedule method Simulation clock. The 
procedure is ineffective for the schedule method Runtime transition. If the schedule is 
recurrent, the schedule is activated on the next new day in the simulation clock. 
 
The RunID argument represents the identifier of the schedule instance. The function 
call raises a runtime error if an instance with identifier RunID exists. If the RunID 
argument is omitted a default sequencing identifier is assigned, which is returned by 
the function. The identifier is to be passed as argument to the below-mentioned 
Terminate statement to deactivate the schedule instance.  

Terminate([RunID  As String ])  

Function(Boolean) . Deactivates an instance of the schedule component. The 
optional argument RunID is the identifier of the schedule instance being terminated. 
An empty string for the RunID argument targets the Autostart instance. Other values 
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for RunID are obtained from the above-mentioned Run procedure. The function 
returns true if the termination is successful. The function call raises a runtime error if 
the non-empty RunID argument does not represent the identifier of an activated 
instance of the schedule. 

Picture procedures 

TypeName 

Function(String). Returns the Type name property. 

Index  

Function(Integer). Returns the index property. 

Name 

Function(String). Returns the name of the object, which is the above-mentioned 
Typename followed by the non-zero above-mentioned Index value.  
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6.8 Clock procedures 

The Renque simulation clock is referenced by the global procedure Clock . The 

simulation clock has a number of functions that are accessible by scripting 
procedures, which can be used to acquire information on the simulation clock status, 
including the current clock date and time. 

General clock procedures 

SimTime  

Function(Variant). Returns the simulation time as floating-point number. Also 
available as global procedure. 

SimTime Limit  

Function(Variant). Returns the Time limit for simulation replications as floating-point 
number. The function returns Nil if no Time limit is specified. 

Replication  

Function(Integer). Returns the current replication number 

Replication Count  

Function(Integer). Returns the total number of replication runs to be performed for 
the current simulation. 

Clock time functions 
Clock time functions return information of the simulation clock in relation to the 
clock time. An error is raised when a Clock time function is called and the Time unit 
of the clock is Dimensionless. The available Clock time functions are: 
StartWeekDay  

Function(Integer). Returns the day number of the clock start day: 1=Sunday ... 
7=Saturday.  

Time  

Function(string). Returns the clock time in the short time format of the system. 

TimeLong  

Function(string). Returns the clock time in the long time format of the system. 

TimeWeekday  

Function(Integer). Returns the current day number of the clock: 1=Sunday ... 
7=Saturday.  

TimeHour  

Function(Integer). Returns the hour number of the current clock time (0-23). 

TimeMinute  

Function(Integer). Returns the minute number of the current clock time.  

TimeSecond  

Function(Integer). Returns the second number of the current clock time. 

Weeks()  

Function(Integer). Returns the week count in the calendar.  

Days()  

Function(Integer). Returns the day count in the calendar. 

Hours()  

Function(Integer). Returns the hour count in the calendar.  
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Minutes()  

Function(Integer). Returns the minute count in the calendar. 

Seconds()  

Function(Integer). Returns the second count in the calendar.  

Clock Calendar functions 
Calendar functions return information of the simulation clock in relation to the 
calendar. An error is raised when one of the calendar functions is called and the 
simulation clock is not Calendar-based. The available clock calendar functions are: 

StartDate  

Function(String). Returns the simulation Start date in the date format of the operating 
system.   

EndDate   

Function(Variant). Returns the simulation End date in the date format of the operating 
system. The function returns Nil if no end date is specified.  

Date  

Function(string). Returns the clock date in the short date format of the system. 

DateLong  

Function(string). Returns the clock date in the long date format of the system. 

DateYear  

Function(Integer). Returns the year number of the current clock date.  

DateMonth  

Function(Integer). Returns the month number of the current clock date. 

DateWeek 

Function(Integer). Returns the week number in the year of the current clock date. 

DateDay  

Function(Integer). Returns the day number of the month of the current clock date. 

DateDayofYear  

Function(Integer). Returns the number of days into the year of the current clock date. 
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6.9 Statistics procedures 

Renque allows statistics recording for operational viewport objects and for variable 
and attribute components. The recorded statistics are stored in so-called statistics 
objects, which is accessible by procedures named Statistics .  

6.9.1 Statistics procedures for viewport objects 

The statistics of server and link objects are accessed through a statistics object 
which is obtained by:  

¶ The server Statistics  function  

¶ The link Statistics  function 

The statistics object returned by these functions is used only in conjunction with the 
below-mentioned statistical property functions.  

Statistical property functions 

Residence; Population; Occupied; Idle; Disabled ; 

Utilization  

Function(Object). Returns the statistical data object for the object property that 
corresponds to the procedure name. The Dis abled  and Utilization  functions 

are not defined for links and block servers. The procedures are available only for a 
statistics object returned by the above-mentioned Statistics  function. The 

statistical data object returned by the function is used only in conjunction with the 
below-mentioned statistical parameter functions.  

Statistical parameter functions 

Current ; Count ; Sum; Mean; Variance ; Minimum ; Maximum; 

Rated  

Function(Variant). Returns the calculated value for the corresponding statistics 
parameter. The functions are available only for the statistical data objects returned by 
one of the above-mentioned statistical property functions. The function call raises an 
error if the Record statistics option has not been selected for the viewport object 
involved. 
Example:  
The statement Server1. Statistics. Residence.Count  returns the number of 

recorded observations for the Residence statistic of the server named Server1. 

6.9.2 Statistics procedures for components 

The statistics of variables and attributes are accessed through a statistics object 
which is obtained by one of the following functions:  

¶ The Statistic s(Var as Variable]  function for global variables 

¶ The server Statistic s(Var as Variable)  function for local variables 

¶ The link Statistic s(Var as Variable)  function for local variables 

¶ The Statistic s[Attrib as Attribute]  function for entity attributes 

The statistics object returned by these functions is used only in conjunction with the 
following statistical parameter functions: 
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Statistical parameter functions for components 

Current ; Count ; Sum; Mean; Variance ; Minimum ; Maximum; 

Rated  

Function(Variant). Returns the calculated value of the corresponding parameter for 
the statistics recorded for the object. The functions are available only for a statistics 
object returned by one of the above-mentioned Statistics  functions for 

components. The function call raises an error if the Record statistics option has not 
been selected for the component. For entity attributes the entity must also have been 
assigned a unique identifier property string. The function returns the value Nil if no 
numerical values have been assigned to the component addressed or no 
observations exist for the specified parameter.   
Example:  
The statement Statistics (Var(1)) . Mean returns the mean of the recorded 

global values for the variable named Var with Index 1. 
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7 Tools & utilities 

Renque has a number of utilities that assist the user in project construction and 
review: 

¶ Alignment utility  

¶ Search utility  

¶ Window arrangement utility  

¶ Script editor 

¶ Picture management 

¶ Preferences  
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7.1 Alignment utility 

The alignment utility allows alignment of the position of servers on the Viewport. It is 
activated by clicking the More.. item of the Align submenu of the Format menu. 
Alignment only affects servers selected in the Viewport. While the alignment utility is 
activated the Workspace window and all Fusion windows are disabled until the 
alignment utility is closed.  
 

 
 
The frames labeled Horizontal and Vertical determine the alignment orientation. The 
options in the Arrangement frame determine the alignment method. The default 
Align option allows alignment of the server object by the options selected in the 
adjacent Horizontal and  Vertical frames. Selection of the Spread option allows 
scaling of the server arrangement by a factor specified in the Stretch factor text 
fields. The Distribute option allows rearrangement organized in rows and columns in 
the configuration specified by the items in the Distribution options frame. 

No change 
No changes are made to the server positions in either the horizontal or vertical 
direction.  

Left, Center, Right 
Aligns the horizontal position of respectively the left-most edges, the center and right-
most edges of the selected server icons to the server object last selected. If all 
objects were selected by a rectangular sweep the alignment reference is the 
horizontal center of the selection. 

Top, Center, Bottom 
Aligns the vertical position of respectively the top-most edges, the center and bottom-
most edges of the selected server icons to the server object last selected. If all 
objects were selected by a rectangular sweep the alignment reference is the vertical 
center of the selection. 

Stretch factor 
Scales the realignment by horizontal and vertical scaling factors 



 Renque user's guide 

- 105 - 

Rows 
Number of rows formed by the alignment.  

Columns 
Number of columns formed by the alignment.  

Square 
Rearranges the server objects into array with square outline.  

Square cells 
Rearranges the server objects into an array with square cells.  

Expand 
Increases the width or height of the selection span to obtain square or square cell 
distribution. 

Contract 
Decreases the width or height of the selection span to obtain square or square cell 
distribution. 
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7.2 Search utility 

The search utility can be used to search for objects in the viewport. It is activated by 
the Find item of the Edit menu, or by pressing the shortcut key combination <ctrl>F 
in the Viewport. The utility can be opened from the Workspace window and from a 
Fusion window. The search domain includes only objects in visible layers of the 
viewport of the window from which the utility was opened. The utility searches for a 
user-specified string. All objects that satisfy the search criterion are selected in the 
Viewport. 
 
When the utility is activated the Find window appears and the Main window and all 
Fusion windows are disabled until the search utility is closed. The utility window has 
a Search text field, where the search string is entered and two option frames which 
determine the search domain and method. 
 

 
 

7.2.1 Search options 

Use pattern matching 
Enables pattern matching using Regular expressions. 

Match case 
Enables case sensitive searching.  

Find whole words only 
Restricts the search to whole words.  

7.2.2 Search domain 

Names 
Searches the Name property of server and link objects.  
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Tags 
Searches in Tags of server and link objects.  

Symbol text 
Searches the Text property of server symbol objects.  
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7.3 Window arrangement utility 

The window arrangement utility can be used to arrange the various windows opened 
by a running instance of Renque on the monitor screen. It is activated by the 
Arrange Windows item of the Window menu.  
 
The utility window contains three frames. The Method frame determines the way the 
window rearrangement is carried out. The frame labeled Windows controls which 
windows are rearranged and determines the repositioning order of the windows. The 
Screen margins frame defines a screen area for placement of the rearranged 
windows. On a system with multiple monitors the windows are placed on the monitor 
on which the utility window is displayed.  
 

 
 

Project windows 
The list in the Project windows frame displays the name of each window of the 
project that may be subjected to rearrangement. The order of the listed items can be 
modified by drag-drop operations. The arrangement is performed for all items 
checked in the list. 

Arrangement method 
Defines the arrangement method. Application of the Cascade option stacks the 
windows in a such manner that overlap of the title bar of the rearranged windows is 
minimized. The Tile option arranges the windows in as many Rows and Columns as 
specified in the two associated text fields, in such a way that no window overlaps any 
other window. For both options the windows are uniformly resized. 

Screen margins [%] 
Defines the margins on all four edges of the target area in percentages of the screen 
height or width.  
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7.4 Script editor 

The script editor is used to compose customization scripts for object incidents and for 
schedule components. 
 

 
 
The inner text area is a standard text editor of the operating system with some 
additional features that assist script coding.  

7.4.1 Coding aids 

Automatic code completion 
This feature automatically fills out script procedure and object names while editing 
scripts. A list of selectable phrases appears in a popup list on the text area when the 
Tab key is pressed. The list contains procedure names which represent an 
appropriate continuation of the text preceding the caret position on the text area. The 
list contains object and component names if the Tab key is pressed together with the 
Ctrl-key. The desired item in the list can be selected with the navigation keys on the 
keyboard. Pressing the Esc-key closes the list. Pressing the Tab key once more or 
the Enter key will complete the text at the caret position with the selected item in the 
pop-up list.  

Procedure syntax help  
Renque provides information on the correct syntax of scripting procedures in the non-
editable help pane at the bottom of the text area. If the mouse hovers over a 
procedure or object name the help pane shows information on the syntax such as 
command argument name and type, function return value type and object type. 

Comment button 
The comment button converts the code on lines with text a selection into a code 
comment by inserting a hyphen character at the beginning of the lines. Comments 
are ignored in execution of the script. 

Script syntax test 
A click on the button at the top left of the script editor performs a syntax test of the 
script. The number of errors is given in the label adjacent to the test button. Each 
error is highlighted in the text area with a distinct background color. Pressing the 
Ctrl-G shortcut key combination selects the text of to the next error in the text area, 
or the previous in combination with the Shift key. The help pane provides an error 
description when the mouse hovers over an error highlight in the text area. 

7.4.2 Find and replace 

A set of text search controls appears above the text area upon pressing the Ctrl-F 
shortcut key combination. A click on the Find button, which is located at the right of 



 Renque user's guide 

- 110 - 

the text field, will highlight all matching occurrences in the script. Additional Ctrl-F 
keystrokes will loop through the search matches by selecting the search matches. 
Holding down the Shift-key as well reverses the loop direction. The command 
Replace all in the context menu of the Search text field replaces all search matches 
by the selected text in the text area. The items in the Search options context menu 
offer several options for the search method applied. The Close button to the left of 
the search text box clears the search and hides the text search controls.  
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7.5 Picture management 

The picture management console is activated by the Pictures command of the 
Tools menu. The picture repository contains pictures that can be used to represent 
servers in the viewport. The console has a picture repository to the left and a tab strip 
on the top right to access different picture property categories for pictures selected in 
the repository. The picture repository provides a list of the pictures in the project. 
Pictures can be added from disk by the New command of the context menu of the 
repository, by dropping a picture file on the repository, or by pasting a bitmap from 
the clipboard into the repository. The picture viewer on the bottom right displays the 
bitmap of the pictures selected in picture repository organized in a grid. A click on a 
picture in the picture viewer deselects all other pictures.  

7.5.1 Masking 

Transparency color 
Defines the transparency mask color of the selected picture. The transparency color 
can be selected by the color selection dialog activated by a click on the adjacent 
color display field. The transparency color can also be selected by a click on a pixel 
in the picture viewer, provided a single picture is selected in the picture repository. 
The transparency mask color is opaque and does not preserve any transparency 
information of the selected pixel.  

Layer substitution color  
Defines the mask color of the selected picture to be substituted with the color of the 
object layer. The layer color can be selected by the color selection dialog activated 
by a click on the adjacent color display field. The layer color can also be selected by 
a click on a pixel in the picture viewer while pressing the Shift-key, provided a single 
picture is selected in the picture repository. The mask color is opaque and does not 
preserve any transparency information of the selected pixel. 

7.5.2 Knots 

Add knot 
Activates knot creating. Picture knots can be used as anchor for attachment of a link 
to a server represented by the picture. A click on the picture viewer with activated 
knot creating results into creation of a new knot in the picture on the mouse position, 
with the knot location indicated in pixels in the text fields labeled X and Y.  

Required link snap opacity 
Specifies the minimum opacity level percentage required for attachment of a link to a 
server represented by the picture. 

7.5.3 Transform  

Crop transparent edges  
Crops the picture by removing transparent edges on all four sides of the items 
selected in the picture repository.  

Replace 
Activates a file browser to select a picture file for replacement of the items selected in 
the picture repository. 
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7.5.4 Animation 

Entity icon scaling 
Activates scaling of entity icons with the viewport scaling factor for entities 
represented by the picture object. If unchecked (default) the picture is displayed in 
the viewport at the picture bitmap size for entity icons, independent of the applied 
viewport scale. 
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7.6 Preferences 

The application and project preferences console is activated by the Preferences 
command of the Tools menu. Selecting an item in the category list at the left side of 
the preferences console presents the corresponding properties pane at right .  
 

 
 

7.6.1 Page properties 

The page properties pane determines the page properties of the project. 
 

 
 

Size (H x W) 
Displays the page size in the selected Project base unit. 

Page spacing 
Determines the page distance on the viewport in the selected Project base unit. 

Show print margins 
If checked, the page margins of the selected printer are displayed by a line in the 
viewport. 
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7.6.2 Grid size 

Spacing 
Determines the distance between the grid lines in the viewport specified in the 
selected Project base unit. 

Offset 
Determines the distance of the top and left grid line to the  page edge specified in the 
selected Project base unit. 

Page break margin 
Determines the required minimum distance to the right and bottom page edges for 
gridlines specified in the selected Project base unit. 

Marker line span 
Determines the display length of the gridlines as percentage of the spacing. 
 

7.6.3 Display properties 

Determines the display properties of the viewport. 
  

 
 

Project base font 
Determines the default font for text in the viewport. A click on the text field opens the  
font picker tool, by which the default font can be changed 

7.6.4 Units 

Project base unit 
Determines the base unit for size display and specification.  

Tolerance 
Not implemented  

7.6.5 Enumerations 
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Base index number 
Determines the lowest index number assigned to new link and server objects. The 
dropdown menu allows selection of the values 0 or 1. 

 

7.6.6 Revision control 

The revision control frame determines the method by which version identification is 
organized.   

Significance levels 
Determines the number of revision enumerations applied to express the significance 
of revision changes. The significance of revisions increases with the enumeration 
level.  

Auto increment 
Determines the method for automated increment of the lowest significance 
enumeration. The dropdown menu allows selection of the values <None>, On save 
and On exit.  The value <None> requires manual revision assignment by the context 
menu of the Revision text field. 

Display format 
Determines the revision display style in the Revision text field and by 
Viewport object text codes. The string specified in the column labeled Separator is 
shown between the significance level values. The Format column requires a 
selection out of the three characters to specify the revision display format. A series of 
hashtag characters (#) represent the minimum number of digits displayed for the 
integer number. The value A presents uppercase letters in the scheme A, B, C ... AA, 
AB... The value a presents lowercase letters by the same scheme. If no format is 
specified the revision enumeration is displayed as unformatted number. 

7.6.7 File locations 

Initial file dialog directory 

Project 
Determines the folder for the Open and Save commands of the File menu. 
 

 
 
The three options are: The Last visited folder by Renque file operations, the 
Documents folder of the operating system, and a Specified location, which is 
assigned in the adjacent text field that appears when selected.  
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Pictures 
Determines the browsing folder for new pictures in the Picture management console. 

Initialization file 
Enables loading a project file with every new simulation project. The file and path 
name are shown in the adjacent text field. The initialization file is selected using the 
browse button to the right of the text field. 

7.6.8 Reference 

Preferred unit system 
Determines the unit base for viewport pages. The dropdown menu has the options 
Metric (millimeters),  Imperial (inches) and None. The selection affects the default 
value for the Project base unit selection and page size parameters. The value None 
uses metric units and ignores standard page sizes.  
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8 Reference 

This section focuses on the architecture of the Renque simulation engine. A brief 
general introduction is followed by a description of the simulation mechanism by the 
following topics: 
 

¶ Simulation mechanism 

¶ Regular expressions 

¶ Viewport object text codes 

¶ Clock display codes 

¶ Script procedure name list 

¶ Script error messages  












































